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1. Disclaimer of Warranty 
In using this software, you understand and agree that this software is provided “as is” without 
warranty of any kind. The entire risk as to the results and performance of using this software 
lies entirely with you, the user. The author does not make any warranties, either expressed or 
implied, with respect to this software. 
 
In no event shall the author be liable for any consequential, incidental, or special damages 
whatsoever (including without limitation damages for loss of critical data, loss of profits, 
interruption of business, and the like) arising out of the use or inability to use this software. 

Copyright and Permissions of the Bible Texts 
As a user of GreekToMe, you must adhere to the copyrights and permissions of the Bible texts 
displayed by GreekToMe, or quit using the program. When © is displayed to the left of the 
translation popup it means that there are legal restrictions on how the translation may be used 
(such as the number of verses you can legally print). When connected to the Internet, you can 
click the © (to the left of the translation popup) to display a related copyright web page. If the 
web page does not open, try using your web browser to display the web page shown in the 
error message. IN ANY CASE, it is your responsibility to investigate and adhere to the current 
copyrights and permissions of the Bible texts you use. 

2. Quick-Start Tutorial 

a. Double-click the GreekToMe###.jar (Java) application located in the GreekToMe 
folder. ### corresponds to the version number. 

b. Set the report to 13. 

 

c. Type disease* in the Search field and press return. 

 



 

 

d. Review the KJV (or other translation) verses that contain words beginning with 
“disease”. 

 

e. Scroll the Verse List to locate your favorite verse and click on that verse in the 
Verse List. 

 



 

 

f. See the verse in the current translation and in Greek. 

 

g. If a large report is taking too long to format, you may cancel it by clicking the 
Cancel button while it is visible. 

 

h. Move the mouse pointer over components (e.g. buttons) to learn their function. 

 

i. Move the mouse pointer over menu items to learn their function. 

 



 

 

j. Choose Quick Reference from the Help menu. 

 

k. Watch some of the demonstrations from the Help:Demonstrate menu. 
 

 
 
 

Keep reading to learn much more! 



 

 

3. Overview 
What is GreekToMe? 
GreekToMe is a software program that aids in the study of the Greek New Testament. 

Who is it for? 
The target audience of GreekToMe is anyone who can read portions of the Greek New 
Testament, but the ability to view and search a translation makes it useful to any Bible student. 
Use an interlinear Bible or the Built-In dictionary to relate Greek words to those in a translation. 

What Greek fonts are supported? 
GreekToMe encodes Greek letters for Unicode fonts (e.g. Arial, Times on Mac OS X; Palatino 
Linotype on PC). If you don't see Greek letters in the Word List and Lexical Word List, use the 
Fonts menu item in the Options menu to change the List Font (Greek) to a different font until 
you see Greek letters. Other suggested fonts are Galatia, Georgia Greek, and Porson. 

How does it work? 
The following picture shows what you would see if you clicked =Abiav in the Word List (letter I). 
Read the descriptions below and then experiment on your own. 
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A The word Abia is found in 2 books. 
B The word Abia is found in 2 verses. 
C =Abiav is the only word selected. 
D Abia has 1 lexical word. 
E Abia is used by 2 authors. 
F In the 2 verses found, Abia has 3 grammars. 
G The word Abia is found in the books of Matthew and Luke. 

 
Hover the mouse over a book name in the Book List to show a tool tip of the long book 
name (if it differs from the displayed book name). 

H The first verse in which Abia is found is Matt 1:7. 
 
Hover the mouse over a verse reference in the Verse List to show a tool tip of its text 
in the current translation. 

I =Abiav is the word that was clicked. =Abia vand =Abia; are both highlighted blue in the 
Word List because the “Auto-Highlight Similarly-Spelled Words with Same Lexical 
Word” option is checked. Without accents, =Abia vand Abia; are spelled the same; but 
because of their Greek accents the program treats these as two different words. Notice 
that word =Abiav is blue and selected whereas the items found (i.e. matching) in other 
lists are highlighted blue, but not selected. Only one list at a time contains selected 
items. 
 
Hover the mouse over a word in the Word List to show a tool tip of that word 
transliterated, and if they differ from the transliterated letters, the letters to type into the 
Word field (letters CC) to select that Greek word. 
 
Clicking a different word in the Word List will unselect any previously selected items in 
the Word List. The means to select an additional word (or extend the range of words) 
in the Word List depends on the operating system of the computer you are using. 
Experiment by clicking in the Word List while holding down the Shift key or Control key 
(or Command key on a Macintosh). The Book, Verse, Lexical Word, Author and 
Grammar Lists operate in the same manner. 
 
Note: GreekToMe considers de and d= to be two different words. To find all words that 
end in an apostrophe, enter *= and press return in the Word field (letters CC). 

J The first (and only) lexical word of Abia is Abia. 
 
Hover the mouse over a lexical word in the Lexical Word List to show a tool tip of that 
word transliterated, its SRN or G/K number (if Show SRN in List option is on), its 
definition in the current dictionary, and its frequency (if Show SRN in Reports or 
Show SRN in Description option is on). 

K Abia is used by authors Matthew and Luke. 
L One of the 3 grammars of Abia, as used in the 2 verses found, is acc. sg. m. n. 
M A description indicating the perspective of the report, or a definition of a Greek word 

clicked in report area. In this example, it is from the perspective of the word Abia 
because a click was made in the Word List. Greek letters are always transliterated in 
the description. If the description contains a URL, and you click in the URL in the 
description, the program will open that web page in your default web browser. 



 

 

N The report popup. The report shown is 13 which displays the verses found, in both the 
current translation and in Greek. A ribbon will appear above the report popup while 
formatting long reports to indicate progress. 

O The current translation is KJV. To the left of the translation popup you may see an 
icon. If it is a copyright symbol (©), clicking it will take you to the web site associated 
with the current translation. If it is a curved arrow, it means the translation file ends 
with “.txt” and clicking it does the same as Reload Translation in the File menu. 

P Use the calculator-like buttons to perform union, subtraction, and intersection set 
operations. Use the “123” button to search for Greek word patterns within verses. See 
Section 9 for details on set operations. 

R This is the report area. If a copyrighted translation is not being displayed, you may type 
in the report area but the next time the report is formatted, it will lose your changes! If 
you click and/or drag in the report area, the fields and lists are filled with information 
pertinent to what was clicked or selected. See Section 12 for details on the interactive 
report area. 

S Click and drag in bottom right corner of the window to resize the window. 
T The Clear button resets all lists and clears the report area; it does not clear the 

memories. 
 

BB Type a verse reference here such as John 3:16 (followed by a return) to select it in the 
Verse List. The Verse List scrolls as you type to indicate what verse will be selected 
when you press return. Typing a back quote (`) while in the Verse field opens the 
Verse Selector dialog. 

CC Type a Greek word here (followed by a return) to select it in the Word List. The list will 
scroll as you type, even if Auto Scroll Lists is unchecked. If what you type could only 
match one word, a return is done automatically. If what you type could not match any 
word, you will hear a beep. You can, but you do not need to enter accented letters to 
find matching words. Enter sim* and press return to select all words beginning with 
sim. Enter *bos and press return to select all words ending with boV. Enter *mna* and 
press return to select all words containing mna. 

DD Type a Greek lexical word here (followed by a return) to select it in the Lexical Word 
List. The list will scroll as you type, even if Auto Scroll Lists is unchecked. If what you 
type could only match one lexical word, a return is done automatically. If what you type 
could not match any lexical word, you will hear a beep. You can, but you do not need 
to enter accented letters to find matching lexical words. Enter sim* and press return to 
select all lexical words beginning with sim. Enter *bos and press return to select all 
lexical words ending with boV. 

EE This pair of buttons (found above the Verse, Word, Lexical Word, and Grammar Lists) 
scrolls the corresponding list to reveal the previous “page” or next “page” that contains 
highlighted list items. Hold down the Shift key and click the top/bottom button to reveal 
the first/last “page” that contains highlighted list items. The buttons next to the Search 
field (letters GG) work similarly, except the report area is searched for the previous or 
next occurrence of the search phrase. 

FF Use the Set Grammars button to quickly search by grammar attributes such as person 
and mood. 
 
Below the Set Grammars button is the Grammar List. Hover the mouse over a 
grammar in the Grammar List to show a tool tip of the unabbreviated grammar term. 

GG Type words here and press return to search the current translation. 



 

 

Type words here and press F9 to search the current dictionary. 
Type any text here and press F3 to search the current report area. 

HH Click the omega w button or press F1 to compose a Greek word and copy it to the 
clipboard. It can then be pasted (e.g. with control-v) into the Word field (letters CC) or 
Lexical Word field (letters DD), or elsewhere. The dark blue keys in the Build-A-Word 
dialog show which keys to press in the Greek font to quickly enter a non-accented 
Greek letter. 

II Click the question mark button to view the Quick Reference dialog. 
JJ Click these preset buttons to change the report to the report number displayed in the 

button. Hold down the Shift key and click a preset report button to set that button’s 
report number. If desired, the Reorder Preset Report Buttons command will reorder the 
preset report buttons by ascending report number. The default preset report buttons 
are 01, 02, 10, 11, 13, 14, 15, 16, 25, 26, 36, 82. 

KK Click this button to switch between Strong's Reference Numbers (SRN) and 
Goodrick/Kohlenberger (G/K) numbers. 

LL Click the a button or press Shift-F1 to compose a Unicode word for the Search field 
(letters GG). 

MM There are three ways to select a verse in the Verse List (letter H). 1) Type the book, 
chapter, and verse in the Verse field (letters BB) and press return. 2) Click the verse in 
the Verse List (letter H). 3) Click the “:” button (letters MM) above the Verse field 
(letters BB) to open the Verse Selector dialog and click the Book, Chapter, and Verse 
radio buttons (followed by the Select button). In the Verse Selector dialog, you can 
press the “-” key to go backward one verse, or “=” (or keypad “+”) to go forward one 
verse. You can click the Select button a second time to bring the main GreekToMe 
window to the front. If you can’t see the Verse Selector dialog because it is behind 
other windows, click the “:” button (or choose Verse Selector from the Windows menu) 
to bring it to the front. 

NN The three alpha (a) buttons adjust the font size of the report area as configured in the 
Font Settings dialog. Click the left a button for the baseline font sizes, click the center 
a button for Jumbo Report Fonts, and click the right a button for Super-Jumbo Report 
Fonts. 

oo The Menu button isn't shown in the picture, but clicking it displays a floating window 
with a list that provides an alternate way of choosing a menu item. If the floating 
window is already visible, clicking the Menu button does the same as clicking the Top 
button. The Top button takes you to the menu bar level. A list item with an arrow 
indicates that it represents a menu and thus it has list items “below” it. The Return 
button takes you up to the previous menu level. Turn on the Keep Open checkbox to 
prevent the floating window from closing after you make a choice. The slider adjusts 
the height of the entries in the floating window. 

 



 

 

Functional Overview Chart 
 

INPUT 
 

 CHOOSE REPORT  OUTPUT 

• Verse List (H)  • Report popup (N)  • Page Setup… 
• Verse Field (BB) 
• Word List (I) 

 • Report menu with keyboard 
shortcuts 

 • Print Report… 

• Word Field (CC) 
• Lexical Word List (J) 

 • Report dialog, 
 ^R & enter 2-digit number 

 • Save Report As… 

• Lexical Word Field (DD)  • Report preset buttons (JJ)  • Dictionary menu 
     
• Author List (K) 
 (F8 if hidden) 

 SEARCH  • Translation popup (O) 
• Translation menu 

  • Build Search Phrase dialog, ^F 
(once or twice), “a” button (LL) 

  

• Set Grammars… dialog 
 (FF) 

 • Search translation (GG), 
 return, or F10 in Search dialog 

 • “SRN” - “G/K” button 
 (KK) 

  • Search dictionary (GG), F9    
• Verse Selector dialog, 
 “:” button (MM) 

 • Search report area (GG), F2, 
F3 

  

     
• Build-A-Word… dialog, 
 “w” button (HH) 

 SET OPERATIONS  Output Options 

 
• Click in Report area (R) 

 • MC, MR, M+, M-, Mx, M1^, 
“123” buttons (P) 

 • Book Names… 
• Font Settings… 

    • Report Spacing 
  NAVIGATION 

 
 • Report Width… 

• Transliterate, etc. 
^ means:  • Scroll to Previous in List (EE)   
 Ctrl key on Ubuntu/PC  • Scroll to Next in List (EE)   
 Command key on Mac  • Scroll Report Area Up, F11   
  • Scroll Report Area Down, F12   

     
IMPORT 

 
 HELP  EXPORT 

• Import Verse List…  • Help menu  • Export Verse List… 
• Import Memories…  • Quick Reference, “?” button 

(II) 
 • Export Memories… 

 



 

 

How do I cancel a report that is taking too long to format? 
Click the Cancel button above the Author List (letter K). The report will read “(Report 
cancelled.)”. 

What are the numbers in the Word List and Lexical Word List?  
The SRN-G/K button (letters KK) controls whether Strong's Reference Numbers (SRN) or 
Goodrick/Kohlenberger (G/K) numbers are displayed. 
 
When the Show SRN in Lists option is checked in the Options menu, you will see the Strong's 
Reference Number (SRN) assigned to each lexical word. James Strong assigned these 
numbers in a book first printed in 1894! The objective of the SRN is to quickly find words and 
verses in the Greek New Testament related to a particular topic without having to read or type 
Greek letters. GreekToMe implements that objective as follows: 
 
If you see an arrow between numbers like 4460£4470 in the Word List it means the Strong's 
Reference Number (SRN) assigned to that word is 4460, but it works better to group it under 
lexical word 4470. A comma between two SRNs like 2564,2570 means the word is grouped 
under two words in the Lexical Word List; you can tell which lexical word applies in a particular 
verse by choosing a detailed report such as report 24. 
 
Occasionally, two lexical words are assigned the same SRN because they refer to similar 
things (e.g. SRN 5621 “ear”). 
 
Some SRNs are missing because they are no longer necessary (e.g. SRN 5104), or because 
the UBS Greek text used by GreekToMe doesn't include them (e.g. SRN 5016 in Mark 13:8 
and John 5:4).



 

 

4. Menus 
File 

Clear/Cancel Report 
Choose this menu item, press the Esc key, or click the Cancel button while a report is being 
formatted to cancel the report. Only the formatting of the report is cancelled; the list selections 
remain. Choosing this menu item or pressing the Esc key when a report is not being formatted 
clears all fields, list selections, and the report area. 

Save Report 
This menu item is convenient if you want to repeatedly save the results of the report area to 
the same filename. For example, you may find it faster to save the report to Untitled.rtf/txt on 
the Desktop and then rename the file on the Desktop. You are reminded if the file already 
exists to avoid accidentally overwriting a previous report. 

Save Report As… 
Invokes the Save dialog for you to enter a filename in which to save the results of the report 
area. You can subsequently open the document with your word processor and adjust tabs, add 
comments, print the report, etc. If the report area contains Unicode characters, you will need a 
Unicode-compatible editor (e.g. TextEdit on Macintosh and WordPad on PC) to make 
changes. Microsoft Word X for Mac OS X is not fully Unicode-compatible, but Microsoft Word 
2004 is! 



 

 

Save Format - Unicode RTF 
Saves report area as a Rich Text Format (RTF) document. The file extension is .rtf. 
 
Though a particular report may not use all the styles, each RTF document defines one 
Paragraph style and five Character styles: 
 

Type Style Name Style Description Used in Reports for… 
Para GTMTitle RTF Font and Size, Bold, 

Centered 
The report area's description. 

Char GTMRegular RTF Font and Size Translation text 
Char GTMBold RTF Font and Size, Bold Verse reference, paradigm 

report row and column headings 
Char GTMGreek RTF Font (Greek) and Size UBS Greek text 
Char GTMGreekBold RTF Font (Greek) and 

Size, Bold 
Highlighted text in UBS Greek 
text 

Char GTMCopyright RTF Font and Size Copyright text 
This color-coded example reveals the six styles: 
 

Lexical Word: Abia 
 

Matt 1:7 and Solomon became the father of Rehoboam, and Rehoboam became the father of 
Abijah, and Abijah became the father of Asa, {Greek "Asaph," alternately spelled 
"Asa" in many English versions here and in the following verse (cf. 1 Chr 3:10)} 

 
 Σολοµ�ν δ� �γ�ννησεν τ�ν �οβο�µ, �οβο�µ δ� �γ�ννησεν τ�ν �βι�, �βι� δ� 

�γ�ννησεν τ�ν �σ�φ, 
 
Scripture quotations from the Lexham English Bible. Copyright 2012 Logos Bible Software. Lexham is a registered trademark of Logos Bible 
Software. http://www.lexhamenglishbible.com 
Greek text Copyright(c) United Bible Societies 1992 3rd Ed. 
 

Operating System Editor Issues during testing 
Mac OS X 10.10.5 TextEdit Works fine for editing/printing, but the Format > Font > 

Styles… command might not work or eventually cause 
TextEdit to crash. 

 Microsoft Word 2008  
 OpenOffice 4.1.1 Works if a new paragraph (\par in RTF) is encountered before 

any text that uses a character style. The title line(s) solve this. 
This is why there is an empty line at the top of the document 
even if the title is blank. 

Windows 10.0 WordPad WordPad doesn't support document styles. 
 OpenOffice 4.1.1 See OpenOffice issue above. 
Ubuntu 14.04 LibreOffice Writer The hanging indent is not cleared on the last paragraph 

(before the copyright) of reports 09 and 82. To fix, quadruple-
click the paragraph, double-click the hanging indent in the 
ruler, and set the “Before text” and “First line” values to 0. 
 

Modifying the font of a character style changes the style's font 
style and size, but not its family. 

Save Format - Unicode Text 
Saves report area as a Unicode Text document (no formatting). The file extension is .txt. 



 

 

UBS Version 
The choices available under this hierarchical menu may be used to change the version of the 
underlying UBS Greek text. Select the desired version and re-launch the program. The History 
window data is stored separately for each UBS version. Because of differences between the 
UBS Greek texts, .mem files (created by Export Memories…) are not compatible between UBS 
versions. 

Open Checklist… 
Loads a checklist (.chk) file created by the Save As… function in the Checklist dialog. One 
possible use of a checklist is to keep track of the Greek words that you do (or don't) know. 
 
(See Commands > More > "Convert Selected Report Text to CheckList" for more 
information about how to start a new checklist.) Below is a picture of an example Checklist 
dialog that was initialized by doing these steps: 
 
1) Select Phil 1:1 in the Verse List. 
2) Choose Report 43. 
3) Select all (or the desired) lines in the report area. 
4) Choose the "Convert Selected Report Text to CheckList" menu item. 
 
The table below this picture explains the components. 
 

 
 



 

 

 
Component Explanation 

Checklist : Untitled This is the Checklist dialog. "Untitled" means the checklist has 
not been saved to a file. 

✓ = 3 of 15 = 20% 3 of the 15 checklist items are marked with a checkmark (✓) 
which is 20% of the checklist items. 

♦ = 1 of 15 = 6.6% 1 of the 15 checklist items is marked with a diamond which is 
6.6% of the checklist items. 

Description (text area) A collection of the description(s) of the checklist items currently 
selected. Because the text can wrap, each item's description 
starts with a bullet (•) character. 

episkopoV The first selected checklist item. It is not checked. Its 
description in the text area is "overseer." 

CristoV The last selected checklist item. It is checked. Its description in 
the text area is "Christ." 

Close Closes the Checklist dialog. You may also press the Esc key or 
click the close box of the dialog window. 

Puzzle Closes the Checklist dialog and brings up the Word Search 
Options dialog. The Puzzle button is enabled when at least one 
checkist item has a checkmark (✓) and there are no unsaved 
checklist changes. See Section 19 for puzzle details. 

Open… Opens a checklist file previously written using the Save As… 
button in the Checklist dialog. You may also press Ctrl-O 
(Ubuntu/Windows) or Cmd-O (Mac). 

Merge… Loads a checklist file and merges it with the current checklist by 
trying to match the titles of existing checklist items. Where there 
is a match, the existing checklist item gets the Description from 
the item being merged. Also, if the item being merged in has a 
checkmark or diamond, it will be turned on in the matching 
existing checklist item. Any non-matching (i.e. new) items are 
added at the bottom of the list. Afterwards, the items selected in 
the list are the items merged. 

✓ Mark Marks (i.e. turns on) the selected checklist items that don't have 
a checkmark (✓) (i.e. are turned off). If all the selected checklist 
items are on, then all those selected checklist items are turned 
off. In other words, if any off, all go on; if all on, all go off. 
 
Hold down the Shift key and click the button to scroll the list to 
the first checklist item that has a checkmark (✓). 
Hold down the Control key and click the button to scroll the list 
to the last checklist item that has a checkmark (✓). 

Mark ♦ Marks (i.e. turns on) the selected checklist items that don't have 
a diamond (i.e. are turned off). If all the selected checklist items 
are on, then all those selected checklist items are turned off. In 
other words, if any off, all go on; if all on, all go off. 
 
Hold down the Shift key and click the button to scroll the list to 
the first checklist item that has a diamond. 



 

 

Hold down the Control key and click the button to scroll the list 
to the last checklist item that has a diamond. 

Save Overwrites the checklist file that is currently loaded. The 
filename is displayed in the Checklist dialog title bar. If the Save 
button is disabled, there are no pending changes. You may also 
press Ctrl-S (Ubuntu/Windows) or Cmd-S (Mac). 

Save As… Writes the checklist file that is currently loaded to a different 
filename. 

Reset All Clears all marks and all selections and scrolls the list to the top. 
Toggle All ✓ Causes every checklist item, regardless of whether it is 

selected, to be turned on if it is off, and to be turned off if it is 
on. Thus, if you click Toggle All ✓ twice it will result in the same 
state as before. 

Toggle All ♦ Hold down the Control key and click the Toggle All ✓ to toggle 
all the diamond marks instead of all the checkmarks. 

Align If checked, the left edge of each checklist item's title is kept 
aligned as its checkmark (✓) is turned on/off. 

Export (on left, below 
checklist items) 

Copies the text of the selected checklist items to the clipboard 
so it can be pasted into an editor and printed, etc. 

Delete Deletes the selected checklist items. Hold down the Control key 
to bypass the confirmation dialog. There is no undo (except to 
discard your changes when exiting the dialog). 

Report Font (Greek) If checked, the current font family and size of the Report Font 
(Greek) is used for the Description text area. Otherwise, it uses 
the same font as the checklist items, which is the List Font 
(Greek). 

Pencil button When a single checklist item is selected in the list on the left, 
the pencil button is enabled, allowing you to edit the Description 
text. (When editing the Description, a tab is allowed, but any 
newline is removed.) 

Export (on right, below 
Description) 

Copies the text of the Description area to the clipboard so it can 
be pasted into an editor and printed, etc. 

✓ Because the List Font (Greek) selected in the Font Settings 
dialog might not have the Unicode checkmark defined, you can 
click this button (repeatedly) to select an alternative character 
for the checkmark that is displayed in the list on the left side of 
the Checklist dialog. It only affects what you see in the list! 

♦ Because the List Font (Greek) selected in the Font Settings 
dialog might not have the Unicode solid diamond defined, you 
can click this button (repeatedly) to select an alternative 
character for the diamond that is displayed in the list on the left 
side of the Checklist dialog. It only affects what you see in the 
list! 

 
  



 

 

Import Verse List… 
Restores the selections in the Verse List by reading a (.vs) file created by the Export Verse List 
command. You can drag and drop one or more files (and/or a folder containing one or more 
such files) created by the Export Verse List command onto the main program window or the 
History window to import it. 

Export Verse List… 
Writes information to a file so that the verses currently selected in the Verse List may be 
restored at a later time via the Import Verse List command. 

Import Memories… 
Restores the (5) memories by reading a (.mem) file created by the Export Memories 
command. You can drag and drop one file created by the Export Memories command onto the 
main program window or the History window to import it. (The current items highlighted in the 
lists are not affected when the memories are loaded. If the MR button happens to be enabled, 
its button text will flash twice in green as a reminder that you must click the MR button to recall 
a memory.) 

Export Memories… 
Writes information to a file so that the contents currently in the (5) memories may be restored 
later via the Import Memories command. Future versions of the program may not be able 
to import your existing memory files, so consider them expendable. Also, these .mem 
files are not compatible between UBS versions. 

Reload Current Dictionary 
Loads the current dictionary file from disk, and regenerates the current report. This is 
convenient if you are working on your own dictionary. 

Reload Current Translation 
Loads the current translation file from disk, and regenerates the current report. This is 
convenient if you are working on your own translation. 

Book Names… 
Used to change the short book names and long book names used in reports. (The Book List 
and Verse List always use the short book names.) 

(More) 

Export Dictionary for Distribution… 
This command is for someone writing a dictionary. The original dictionary file can contain 
comments (before and after the /*…*/ on each line) so this command creates a new dictionary 
file without those comments—only the dictionary definitions. If the dictionary being exported is 
not complete (because it has “?” or empty definitions), a dialog shows the percentage 
complete. A line is produced in the output file for each SRN (or G/K) number. The definition for 
an invalid SRN is “-”. If a definition was not provided in the source dictionary file, the default 
definition for a SRN or G/K number not used by GreekToMe is “n/a” (which means not 
applicable). The result is that the SRN or G/K number matches its line number in the exported 
dictionary file. The Built-In dictionary can't be exported at this time. 



 

 

Create Starter SRN Dictionary… 
This command is for someone writing a dictionary. Creates a new SRN-based dictionary file 
numbered 1 through 5624. If the number is not a valid Strong's Reference Number (SRN), the 
dictionary entry is “-”. Keep those “-” lines (SRN 2717 and SRN 3203..3302)! They are 
placeholder lines so that the line numbers of the file match the SRN number for fast “goto line” 
navigation in an editor. If the number is a valid SRN, but the number is not used by 
GreekToMe, the dictionary entry is “/*n/a*/” (which means not applicable). Consider them 
placeholder lines too. You may substitute a real dictionary definition for “n/a” if you are writing 
a SRN dictionary for another purpose. See Section 11 of this document for more information 
on the /*…*/ format. If you are not going to have comments in your dictionary work file, you can 
use a text editor to remove “/**/” from the file. But before you do, realize that “/**/” is an easy 
way to search in the file for dictionary entries that don't have a definition yet. 
 
Here are the available default definitions you can choose, along with an example dictionary 
definition that you could produce by manually editing the dictionary file afterwards: 
 

Default Format Default Line in File Sample Manually-Edited Line in File 
Empty definition 2574 /**/ 2574 camel 

2574 /*camel*/ My notes, not part of definition. 
SRN or G/K 2574 /*=1223=*/ http://concordances.org/greek/2574.htm 
Lexical Word† 2574 /*=κάμηλος=*/ https://lsj.gr/wiki/κάμηλος 
Lexical Word 
encoded for 
URL‡ 

2574 
/*=%CE%BA%CE%
AC%CE%BC%CE%
B7%CE%BB%CE%
BF%CF%82=*/ 

https://lsj.gr/wiki/ 
%CE%BA%CE%AC%CE%BC%CE%B7%CE%B
B%CE%BF%CF%82 

Transliterated 
Lexical Word 

2574 /*=kamēlos=*/ http://www.teknia.com/greek-dictionary/kamelos 
(notice the ē in kamēlos was edited here to be e) 

 
† Works when URL-based dictionary entry is clicked in Mac OS and Ubuntu. 
‡ Works when URL-based dictionary entry is clicked in Mac OS, Ubuntu, and Windows. For 
more information on URL encoding see https://www.w3schools.com/tags/ref_urlencode.asp. 
 
Choose the /*=SRN=*/ option if you want to create a SRN dictionary file for URLs that will 
contain the SRN number. Afterwards, use a text editor to replace /*= with the first part of a 
URL, and replace =*/ with the last part of a URL. 
 
For example, consider this default dictionary entry for SRN 2574: 2574 /*=2574=*/ 
 
Use a text editor to replace all the occurrences of 
 /*= 
with 
 http://concordances.org/greek/ 
 
and replace all the occurrences of 
 =*/ 
with 
 .htm 
 



 

 

The resulting definition for SRN 2574 in your dictionary file would be: 
 
2574 http://concordances.org/greek/2574.htm 
 
When http://concordances.org/greek/2574.htm (or any URL of your choice) is clicked in the 
report area (letter R), the program will open that web page in your default web browser. If a 
URL in a dictionary file contains an ampersand (&), it must be entered as: &amp; 

Create Starter G/K Dictionary… 
This command is for someone writing a dictionary. Creates a new G/K-based dictionary file 
numbered 1 through 6068 (with 899a as the last line). Please read “Create Starter SRN 
Dictionary…” above. 

Create Starter Translation… 
This command is for someone writing a translation or a file for notes. Creates a new translation 
file containing a line for each New Testament verse reference used by GreekToMe. Do not 
change the book names in the translation file if you plan for GreekToMe to eventually 
read the file. Even if you are using this command only to create a file for Bible notes, see 
Section 10 of this document for more information. 
 
You have two options for the default translation text. One choice is a question mark, such as: 
 
1John 5:4 ? 
 
The other choice is a sample URL, such as: 
 
1John 5:4 https://myserver/mypath/BOOK=1_john/CHAPTER=5/VERSE=4.htm 
 
After creating the new translation file, you can carefully edit the file with a text editor using 
steps like these: 
 
• Change "myserver/mypath" to "interlinearbible.org" 
• Change "BOOK=" to "" 
• Change "CHAPTER=" to "" 
• Change "/VERSE=" to "-" 
 
to get a line like this: 
 
1John 5:4 http://interlinearbible.org/1_john/5-4.htm 

Create G/K Dictionary… 
This command is for people writing a dictionary. The definitions in the current (SRN-based) 
dictionary are reordered by their corresponding G/K number and written to a dictionary file. G/K 
“899a” is the last line of the file. See the related G/K dictionary topics in Section 11 of this 
document. 
 
Some lexical words share a SRN. For example, lexical words Admin and Aram both use SRN 
689. When the G/K dictionary is created, both G/K 98 (Admin) and G/K 730 (Aram) will have 



 

 

the same definition. You may edit the new dictionary file to refine one or both of these G/K-
based definitions. To determine the other lexical words that share a SRN (steps 1 and 2) and 
their corresponding G/K numbers (step 3), perform these three steps: 
 
 1) Click the SRN-G/K button (letters KK) until it reads SRN. 
 2) Choose the “Lexical Words Sharing SRNs” menu item. 
 3) Click the SRN-G/K button (letters KK) until it reads G/K. 

Show Translation Progress 
This command is primarily for people writing a translation, but it can be informative for any 
translation file. It displays in the report area the count of the verses in each book that are 
translated/untranslated. A verse is considered untranslated if its text is exactly a question mark 
(?) or the verse is missing in the translation file. The list of possible verses is based on those 
coded in the program, some of which aren't in the USB Greek text, and some of which the 
translators chose not to translate. The first and last untranslated verse of each book is also 
displayed. 

Page Setup… 
Invokes the page setup dialog to adjust paper orientation. The settings are not remembered 
when quitting the program. 

Print Report… 
Invokes the print dialog to print the report area. 

Quit, Don’t Save Settings 
Quits the program without saving your settings. 

Quit 
Saves your settings made since the program was last launched, and quits the program. The 
settings are stored in the GreekToMe.ini file. 
 
For advanced users: If a GreekToMe.ini file is not found in the Override Location when the 
program is launched, the Default Location is used.  
 

 Default Location 
(usually in a hidden folder) 

Override Location 

Macintosh ~/Library/Preferences/GreekToMe.ini same folder as GreekToMe.jar 
Ubuntu ~/.config/GreekToMe.ini ~/GreekToMe.ini 
Windows C:\Users\<username>\AppData\ 

Roaming\GreekToMe\GreekToMe.ini 
same folder as GreekToMe.jar 



 

 

Report 

Report ## Spacing 
Inserts blank lines in report for readability. Each report has its own spacing setting. 

Set Report Width 
Adjusts the width of the Word and Lexical Word columns in reports 22..26, 35..37, and 43..44. 

Decrease Report Width 
Subtracts 5 from the report width percentage and reformats the report. 

Increase Report Width 
Adds 5 to the report width percentage and reformats the report. 

The Reports 
The menu items available under these hierarchical menus are equivalent to those in the report 
popup (letter N). Many of the Report menu items have keyboard shortcuts. You might think of 
0=none, E=English, G=Greek, B=Both Translation and Greek, D=Dictionary, L=a Long report, 
M=GraMMar. Here are the available reports: 
 
 

Report Number Report Description 
00:  None This empty report saves time when entering many 

verses. 
01:  Verses (vertical) A list of highlighted verses in the Verse List, one verse 

per line. 
02:  Verses (compact) A concise summary of highlighted verses in the Verse 

List. 
03:  Syllables Like report 02 plus the syllables of the highlighted Greek 

words in the Words List. For those who want to practice 
speaking each Greek syllable. 

09:  Reader’s Greek Displays Greek with lexical word definitions at the bottom 
for Greek words occurring less frequently in the Greek 
New Testament. 

10:  Greek Good for practicing reading Greek (with no hints). 
11:  Translation For casual reading of highlighted verses in the current 

translation. 
12:  Translation / alphabetical highlighted Greek 
words 

Like report 13 except only the highlighted Greek words 
used in the verse. 

13:  Translation / Greek Good for comparing a translation with the Greek. 
14:  Translation / Greek (grammar) Like report 13 plus incorporates grammar into text. 
15:  Translation / Greek (dictionary :: grammar) Like report 13 plus incorporates grammar and dictionary 

into text. 
16:  Greek / All Translations For comparing verses in all translations with the Greek. 

(The current translation is displayed below the Greek.) 
17:  Greek / Translation Like report 13 with the Greek and translation swapped. 
21:  Trans / Words Good for word studies -- Greek words displayed 

vertically. 
22:  Trans / Words..Grammar Like report 21 with the word's grammar. 
23:  Trans / Words..Lexical Word Like report 21 with the word's lexical word(s). 
24:  Trans / Words..Lexical Word..Grammar Combination of reports 22 and 23. 
25:  Trans / Words..Lexical 
Word..Grammar..Dictionary 

Like report 21 with the word's lexical word(s), grammar, 
and dictionary text. 



 

 

26:  Trans / Words..Lexical Word / 
Grammar..Dictionary 

Like report 25 except stacked vertically, thus not as 
wide. This report can be slow if not using Java 1.6 or 
later. 

30:  Words..Lexical Word Highlighted words with their lexical word(s). 
31:  Words..Grammar Highlighted words with grammars as used in highlighted 

verses. 
32:  Words..Grammar..highlighted verses Highlighted words with each grammar and highlighted 

verse(s). 
33:  Words..all grammars..all verses using Highlighted words with all possible grammars and all 

verses having that Greek word. 
34:  Words..all authors using (times in N.T.) Highlighted words with all the authors that use that 

(accent-specific) Greek word, sorted by descending 
times used in the whole Greek New Testament. See 
option "Include Percentage in Reports 34, 46". 

35:  Words..Lexical Word..Dictionary Highlighted words with their lexical word(s) and 
dictionary text. 

36:  Words..Grammar..Lexical Word..Dictionary Like report 35 with grammars as used in highlighted 
verses. 

37:  Words..Grammar..SRN (or G/K) Highlighted words with their grammars and SRN (or 
G/K). 

38:  Words..SRN (or G/K) Highlighted words with SRN (or G/K). 
40:  Lexical Words Highlighted lexical words in the Lexical Word List. 
41:  Lexical Word..Translation / Greek Verses containing words derived from the highlighted 

lexical words. 
42:  Lexical Word..Translation / Greek (grammar) Like report 41 with the derived word's grammar in 

parentheses. 
43:  Lexical Words..Dictionary Like report 40 with dictionary text. 
44:  Lexical Words..Dictionary (sorted by SRN or G/K) Like report 43 except sorted by SRN (or G/K). 
45:  Dictionary (sorted by SRN or G/K) Dictionary sorted by SRN (or G/K). 
46:  Lexical Words..all authors using (times in N.T.) Like report 34 except for lexical words. 
47:  Lexical Words..highlighted books (times in 
book) 

Highlighted lexical words for the books highlighted in the 
Book List. 

50:  Authors Highlighted authors in the Author List. 
50:  Authors..alphabetical highlighted Greek words Highlighted words by Author 
50:  Authors..alphabetical highlighted Greek lexical 
words 

Highlighted lexical words by Author 

60:  Books Highlighted books in the Book List. 
70:  Grammars Highlighted grammars in the Grammar List. 
71:  Grammar..alphabetical highlighted Greek 
words 

Highlighted grammars with highlighted Greek words 
having that grammar. 

72:  Paradigm Charts A graphical way of organizing words based upon their 
grammar in the context of the highlighted verse(s). 

80:  Translation Words by Frequency A count of the translation words of highlighted verses in 
the Verse List. 

81:  Translation (book reading) Use with single-spacing for book-like casual reading of 
highlighted verses in the current translation. 

82:  Worksheet for translating Greek passages Combination of reports 10 and 11 (as a compact block). 
83:  All Translations, Words by Frequency Words of all translations of highlighted verses in the 

Verse List, along with the translations that have each 
word. If you have your own translation file (possibly 
containing notes) which you want to exclude from this 
report, put a tilde its filename such as My~Notes.txt or 
MyNotes~.txt. 

Change Report… 
Invokes a small dialog in which you can type two digits corresponding to the desired report 
number. The dialog closes when the second digit is typed. Press Esc to cancel the command. 



 

 

Auto Change Report 
The menu items under this hierarchical menu may be used to cause the report to change 
automatically when performing certain operations. 

(Greek Word Sorting) 
The menu items in this hierarchical menu affect the sorting of Greek words when they are 
listed in reports. Lexical words in reports are not affected. This Greek word sorting is 
noticeable in reports 12, 30..37, and 71. Since these sorting options are expected to be used 
infrequently, the menu items under the Greek Word Sorting menu are reset to their default 
settings each time the program is launched. 

(Paradigm Case Order) 
The menu items in this hierarchical menu affect the order of the Greek cases in report 72. 

Ignore Word Length 
If checked, the length of Greek words does not matter. 

Shorter Words First 
If checked, shorter words are first in the sort order. If two or more words are the same length, 
they are sorted alphabetically (see Descending Alphabetical). 

Longer Words First 
If checked, longer words are first in the sort order. If two or more words are the same length, 
they are sorted alphabetically (see Descending Alphabetical). 

Descending Alphabetical 
If checked, alphabetical sorting is descending (e.g. b before a). Otherwise, alphabetical sorting 
is ascending (e.g. a before b). 

Right-To-Left (e.g. treat “legw” as “wgel”) 
This sorting option may be useful when listing Greek words with similar endings. For the sake 
of sorting, the letters are reversed inside the program (e.g. treat “legw” as “wgel”). Though not 
necessary, the author recommends checking the Ignore Word Length menu item, and 
unchecking the Descending Alphabetical menu item when using the Right-To-Left sorting 
option. 

Search 

Enter Search Phrase 
Takes you to the Search field to change the search phrase, rather than clicking in the Search 
field with the mouse. After typing the search phrase, press return to search the current 
translation (and regenerate the report), press F9 to search the current dictionary and display 
matching dictionary entries, or, press F2 or F3 to search the existing report area. If the Search 
field is already the active component when this command is chosen, the Search Phrase Dialog 
will open. 



 

 

Build-A-Word… (F1) 
Invokes a dialog with buttons you can click to compose a Greek word in Unicode. You can also 
type the blue letter displayed in the button below each non-accented Greek letter to enter that 
non-accented Greek letter. Switch between lowercase and uppercase letters by pressing F1 or 
clicking the omega button to the left of the Cancel button. Press the delete key on your 
keyboard to undo the last entry. The accented letters displayed are limited to those found in 
the Greek New Testament. Some additional Unicode characters are displayed at the bottom 
for your convenience in writing documentation. A copy mode button allows for encoding the 
current phrase as HTML (that may be pasted into a translation or dictionary file). 
 
Copy Mode When the current phrase is copied to the clipboard… 
Text Copy the current phrase as it is displayed. 
HTML Encode the current phrase for HTML. 
HTML2 Same as HTML, but with non-breaking spaces. 

 

Build Search Phrase… (Shift-F1) 
Invokes a dialog with buttons you can click to compose a word in Unicode. The initial search 
phrase is what is found in the Search field. You can also type the letter if it is colored blue in a 
(non-accented) button. The &, |, ~, and * buttons are explained in Section 6. Press the delete 
key on your keyboard to undo the last entry. The accented letters displayed are limited to 
those found in the current translation and dictionary. If you click OK or press the return key, the 
dialog will close and current search phrase will be copied to the Search field. You can then 
press return to search the current translation, F9 to search the current dictionary, or F3 to 
search forward in the report area (letter R). To combine these two steps into one, you can 
press F10, F9, or F3 while in the dialog. Pressing F3 while in the dialog searches forward 
beginning at the start of the report area. 

Find Previous (F2) 
Searches backward in the report area (letter R) from the current search position for the 
previous occurrence of the case-insensitive search phrase. The phrase is selected in the 
report if found. Otherwise, the insertion point is placed at the beginning of the report. Relational 
operators and wildcards (see Section 6) do not work when searching the report area. 

Find Next (F3) 
Searches forward in the report area (letter R) from the current search position for the next 
occurrence of the case-insensitive search phrase. The phrase is selected in the report if found. 
Otherwise, the insertion point is placed at the beginning of the report. Relational operators and 
wildcards (see Section 6) do not work when searching the report area. 

Clear Report and Enter…Verse (F4) 
Clears the report area (letter R) and takes you to the Verse field (BB). 

Clear Report and Enter… Word or SRN/G/K (F5) 
Clears the report area (letter R) and takes you to the Word field (CC). 

Clear Report and Enter…Lexical Word or SRN/G/K (F6) 
Clears the report area (letter R) and takes you to the Lexical Word field (DD). 



 

 

Clear Report and Enter…Search Phrase (F7) 
Clears the report area (letter R) and takes you to the Search field (GG). 

Search Current Dictionary (F9) 
Searches the current dictionary for the phrase in the Search field (GG). See Section 6 on 
Entering Search Text for more information. The report is automatically changed to Report 43. 

Search Current Dictionary Words (Shift-F9) 
Fills the report area (letter R) with a sorted list of words found in the current dictionary. This 
could be useful to determine what words to search for in the Search field (before pressing F9). 
If the dictionary text contains braces, the words within the { } are ignored. Choosing this 
command changes the current report to 00 (None), but you can change the report back (e.g. 
letter N) to what it was to resume. 

Search Current Translation Words 
Fills the report area (letter R) with a sorted list of words found in the current translation. This 
could be useful to determine what words to search for in the Search field (before pressing 
return). If the translation text contains braces, the words within the { } are ignored. Choosing 
this command changes the current report to 00 (None), but you can change the report back 
(e.g. letter N) to what it was to resume. 

Scroll Report Area Up (F11) 
Scrolls the report area (letter R) up without changing the active component. 

Scroll Report Area Down (F12) 
Scrolls the report area (letter R) down without changing the active component. 

Select Report Area 
Selects all the text in the report area (letter R) for copying, etc. 

Move Into Report Area 
Makes the report area (letter R) the active component so you don’t have to click the mouse in 
the report area to start scrolling it. This command doesn’t work on Windows if a list is currently 
the active component. 

Highlight Everything! 
The fastest way to highlight every verse in every book for doing reports based upon the entire 
Greek New Testament. 

Translation 

Translation 
Although you can change the current translation using the translation popup (letter R), they are 
also displayed here—along with their keyboard shortcuts. 



 

 

Translation Order… 
Enter one or more translation names (separated by a comma) to move them to the top of the 
Translation menu. For example, entering “YLT, KJV” will cause YLT to be displayed at the top, 
followed by KJV, when the program is re-launched. (If the YLT.gtm file does not exist in the 
translations folder then YLT is ignored and KJV would be displayed at the top.) The remaining 
translations found in the translations folder are added in alphabetical order after those menu 
items. The names entered in the dialog are case-insensitive. For visual separation, a hyphen 
entry such as in “YLT, KJV, -, NASB, -” will output one additional blank line in Report 16 after 
the KJV and NASB lines. 

Copyright Agreement… 
Displays the copyright and permissions message. 

Rotate To Next Translation 
Changes the next translation to the next translation down in the Translation menu, rotating to 
the first translation if the current translation is the last Translation menu item. 

Recall Last Translation 
After changing the translation, use this command to return to the last chosen translation. 

Dictionary 
The Dictionary menu allows you to choose a Greek dictionary for use in reports. Choosing a 
Dictionary menu item loads (or reloads) the dictionary file from the disk, and regenerates the 
report if it uses dictionary entries. 

Dictionary Order… 
Enter one or more dictionary names (separated by a comma) to move them to the top of the 
Dictionary menu. For example, entering “Strongs, Built-In” will cause Strongs to be displayed 
at the top, followed by Built-In, when the program is re-launched. (If the Strongs.txt file does 
not exist in the dictionaries folder then Strongs is ignored and Built-In would be displayed at 
the top.) The remaining dictionaries found in the dictionaries folder are added in alphabetical 
order after those menu items. The names entered in the dialog are case-insensitive. 

Commands 

Select Verse Previous 
Selects the verse before the first highlighted verse. 

Select Verse Next 
Selects the verse after the last highlighted verse. 

Select Verse Random 
Selects a verse at random. 

Add Verse Previous 
Adds the verse prior to the first highlighted verse to those verses already highlighted. 



 

 

Add Verse Next 
Adds the verse after the last highlighted verse to those verses already highlighted. 

Add Verse Random 
Adds a verse at random to the verses already highlighted. 

Convert Selected Report Text to HTML in Clipboard 
Converts the text that is currently selected in the report area to HTML, and puts that HTML in 
the clipboard. This is useful if you are working on your own translation file and you want to 
include text from the report area (letter R) that contains an accent or breathing mark, so that 
you can afterwards paste the clipboard into your translation file. For example, in John 11:54, 
the HTML for κἀκεῖ is &kappa;&#7936;&kappa;&epsilon;&#8150; and example translation 
note could read: 
 
John 11:54 ... AND THERE{&kappa;&#7936;&kappa;&epsilon;&#8150; with a 
coronis mark is a crasis (i.e. crash) of &kappa;&alpha;&#8055; + 
&#7952;&kappa;&epsilon;&#8150;} HE REMAINED WITH THE DISCIPLES. 

Convert Selected Report Text to Checklist 
Converts the text that is currently selected in the report area to a checklist, which is then 
displayed in the Checklist dialog. (Information about the Checklist dialog may be found in the 
description of the File > Open Checklist… menu item in this document.) 
 
Only certain lines of text selected in the report area (letter R) can qualify to become a new 
checklist item in the Checklist dialog. In the examples in the table below… 
 
• X represents the checklist item text 
• Y represents the checklist item description 
• <tab> represents a tab character, which is an example of a whitespace character 
 
What kind of line qualifies for a new 
checklist item in the Checklist dialog? 

Example Line Item Description 

If the line is empty, or if it is empty after doing 
any pre-processing (such as after removing a 
diamond character), it is ignored. 

   

If the line is a copyright line for the UBS Greek 
text, it is ignored. 

Greek source: 
The Greek…   

If the line contains the copyright line for a 
translation file, it is ignored. 

YLT<tab>The 
Young's Literal…   

If a line starts with any whitespace (like a tab 
or space) it is ignored. <tab>X   

This line will create a new checklist item labeled 
X, but it has no description. X X  

This line will create a new checklist item labeled 
X with description Y. X<tab>Y X Y 
If the description is a question mark (?), then 
the new checklist item will have a checkmark. X<tab>? ✓ X Y 



 

 

If a line starts with a period (.), the period is 
removed, and any whitespace that immediately 
follows the period is removed. 

. X<tab>Y 
becomes 
X<tab>Y 

 
 
X 

 
 
Y 

If a line starts with a checkmark (✓), the 
checkmark is removed, any whitespace that 
immediately follows the checkmark is removed, 
and the new checklist item will have a 
checkmark. 

✓ X<tab>Y 
becomes 
X<tab>Y 

 
 
✓ X 

 
 
Y 

If a line contains a solid diamond (♦), the 
diamond is removed, and the new checklist 
item will have a diamond. 

X♦<tab>Y 
becomes 
X<tab>Y 

X ♦ Y 

 
Important: If you ever need to copy the Unicode checkmark or solid diamond character used 
by GreekToMe, use the Help > Unicode "Palette" command and then copy that character from 
the report area. (They are the same Unicode characters as the ones copied to the clipboard 
when you use the left Export button located below the list in the Checklist dialog.) 
 
If you think about it, the source text for a new checklist doesn't have to originate in 
GreekToMe. With the above "rules" in mind, you can temporarily paste text from any source 
into the report area (if it is currently editable), select that text, and then chose the "Convert 
Selected Report Text to Checklist" menu item. 
 
As an example of how easy it is to create a checklist, here are steps to create a checklist of 
particles in the New Testament: 
 
1) Click the Set Grammars… button and turn on the Particle checkbox. Click OK. If you get a 
Large Report Warning click "No". 
2) Choose Report "43: Lexical Words..Dictionary". 
3) Select all (or the desired) lines in the report area. 
4) Choose the "Convert Selected Report Text to CheckList" menu item. 
 
Another example is to select the book of 3John in the Book List, choose Report 36, and then 
do steps 3 and 4. This results in a checklist of every word (with its accents) in 3John. 
 
If doing step 4 above would ever result in no checklist items, the lines of text are internally 
trimmed of leading whitespace and processed again. To try this out, switch to Report 24, select 
a verse in the Verse List, and then select only the lines in the report area that begin with a tab. 

Convert Selected Report Text to Translation Note in Clipboard 
Converts the text that is currently selected in the report area to a translation note in the 
clipboard which can then be pasted into a verse in a GreekToMe text-based translation file. 
For example, click on Matt 1:1 in the Verse List. If you select the phrase "the son of Abraham" 
in any English translation and chose this menu command then "{the son of Abraham}" would 
be put into the clipboard, which could be pasted into your translation file (and then modified 
according to what particular note you wanted to make). 
 
Because the text in a GreekToMe translation file must be HTML-compatible, you might find two 
sets of braces {…}{…} when you paste. In that case the left-most set of braces is more 



 

 

readable to a person, but the right-most set of braces is the set of braces that is compatible 
with a GreekToMe translation file; use only the right-most set in the translation file. Here is 
an example of two sets of braces for a Spanish word having an accented letter: 
{genealogía}{genealog&iacute;a} 

Convert Selected Report Text to Translation Note in Clipboard with References 
This menu command is available for reports 16, 35-37, 43-44, 46, 80, and 83. It is like "Convert 
Selected Report Text to Translation Note in Clipboard" except that additional information is 
added in the translation note in the clipboard. For example, enter Rom 9:7 in the Verse List 
and choose Report 16. Select the word "Abraham" in the text area and choose this menu 
command. The translation note will contain a compact comma-delimited list of translation 
abbreviations obtained from the beginning of the lines of text in the entire report area that 
contained case-insensitive "Abraham", followed by ": " and the word/phrase that was selected. 
 
With Rom 9:7 still selected in the Verse List, switch to Report 83. Select "Abraham" anywhere 
in the report area and choose this menu command. The translation note will contain the sum of 
the no. of times "Abraham" is found among the listed translations, as well as a comma 
delimited list of words that contained case-insensitive "Abraham", followed by ": " and the 
word/phrase that was selected. The count is the sum of the numbers at the beginning of the 
lines of Reports 80 or 83, and the list of words comes from what is between the first and 
second tab characters of the lines that contained the text you selected. Here is an example if 
"Abraham" is selected: 
{#x: Abraham, Abraham's, d'Abraham: Abraham} 
where # is the sum [and where the matching words are] based on what translation(s) are in 
your report area when using Report 80 or 83. 
 
If the current report is Report 83, the searchable text in the report area is between the first and 
second tabs in a line of text — in other words, what appears as the second column of text in 
Report 83. Otherwise, the searchable text in the report area is after the first tab in a line of text. 
A line is ignored if it is a copyright line for the UBS Greek text or a copyright line for a 
translation file. A line is ignored if the text before the first tab contains a tilde (~) character. 
 
See the Options > More > Show 'Convert to Translation Note with References' Result 
menu item. 

Reader’s Greek Settings… 
As one advances in their ability to read the Greek New Testament they require less “hints” as 
to what the Greek words mean. This dialog allows you to control two aspects of Report 09 that 
determine how many dictionary definitions are displayed in the report. They are the word 
frequency, represented by <W>, and the lexical word frequency, represented by <LW>. If <W> 
is 5, for example, a definition will be displayed for words that appear 1 to 4 times in the Greek 
New Testament. If <LW> is 30, for example, a definition will be displayed for a word if the total 
occurrences of all the words related to its Lexical Word is 1 to 29 times in the Greek New 
Testament. So <W> is the threshold for a particular word (ignoring accents), and <LW> is the 
threshold for the group of words under each lexical word. If desired, you can set the value of 
<W> to 1 to cause the <W> value to be ignored (so that only <LW> matters), or the value of 
<LW> to 1 to cause the <LW> value to be ignored (so that only <W> matters). 



 

 

Select Reader's Greek Words 
Selects the words that correspond to the current Reader's Greek Settings. 

Frequently Used Words… 
Word frequency is how many times a Greek word is used in the Greek New Testament. You 
enter the minimum and maximum frequency values of the words to select. Enter 500 and 9015 
to select the words used 500 or more times. Enter 100 and 104 to select the words used 
100..104 times. Enter 100 and 100 to display the words used 100 times. The word frequencies 
of same-spelled words that share a lexical word are combined. 

Similar Verses… 
Selects verses that share a lexical word. The idea is to try to discover one or more verses that 
are “similar” to one or more other verses. The program conveniently presents the data for you, 
but you must decide what lexical words you care about, and whether any of the resulting 
“similar” verses are applicable to your studies. Green text is used here to differentiate the lists 
in the Similar Verses dialog from the lists in the main GreekToMe window. 
 
Before you can use this command, one or more verses must be selected (or highlighted) in the 
Verse List of the main GreekToMe window. Those selected (or highlighted) verses get 
copied to the Verses list. The picture below shows that Matt 18:18 was selected before the 
Similar Verses… command was chosen. 
 
After the Similar Verses dialog opened, SRN 1210 and 3089 were selected (manually) in the 
Lexical Words list. This revealed that 10 verses have occurrences of a word derived from 
lexical word dew (SRN 1210) and a word derived from lexical word luw (SRN 3089). 
 



 

 

 
 
Note that by using a lexical word approach to try to discover similar verses, the current 
Translation chosen in the main GreekToMe window does not affect the verses that appear in 
the Similar Verses list. 
 
In this example, it could be concluded that Matt 16:19 is similar to Matt 18:18.

Verses list 
of the Similar Verses dialog 

Similar Verses list 
of the Similar Verses dialog 

Lexical Words list 
of the Similar Verses dialog 



 

 

If you select one or more verses in the Similar Verses list, the “Send to Verse List & Close” 
button becomes enabled. Click that button to select those same verses in the Verse List of 
the main GreekToMe window, and also close the dialog. 
 
Or, click the Reinitialize button to copy the verses you selected in the Similar Verses list to the 
Verses list in the upper-left corner of the dialog. 
 
The number in parentheses to the left of each lexical word in the Lexical Word list is the 
number of times that lexical word is used among all of the verses selected in the Verses list 
above it. If the “Sort by occurrences” checkbox is checked, the Lexical Word list is sorted by 
descending number. The total lexical word frequency in the Greek New Testament is always 
shown at end of each lexical word's dictionary definition. 
 
If the “Sort by relevance” checkbox is checked, the Similar Verses list is sorted with the “most 
similar” verses at the top. 
 
Though powerful, the similar verses feature is far from perfect. The search method depends on 
Greek lexical words and it doesn't span multiple verses. Two Bible writers might not use the 
same Greek lexical words to describe the same event. This makes it difficult for the program to 
find a parallel passage. Selecting one or more nouns in the Lexical Words list might yield 
better results. One example that yields good results is Matt 13:7 selected in the Verses list with 
the lexical word for “thorn” selected in the Lexical Words list. 
 
Technical notes: The way the relevance is determined (when “Sort by relevance” is on) is by 
comparing the unique translation words of each verse selected in the Verses list with the 
unique translation words of each verse in the Similar Verses list. If there are 3 verses selected 
in the Verses list, and 25 verses in the Similar Verses list, it means that 75 comparisons are 
done. Every time a (case-insensitive) word matches between the verses being compared, the 
verse in the Similar Verses list increases its score. (Scores are hindered if the translation uses 
different words to translate the same Greek word, such as both “love” and “charity” for SRN 26 
in the KJV.) If a verse selected in the Verses list has the word “said” and a verse in the Similar 
Verses list has the word “says”, then those two words don't match. In contrast, the words 
“spirit” and “Spirit” do match. This is a simplistic mechanism for matching words among verses, 
but it works pretty well overall! Attempting to match two translation words in any language 
(such as “said” and “say”) would involve massive complexity. 

Statistically Complex Verses… 
The program assigns a complexity value to each verse based on the word frequency of the 
words used in the verse. Statistically speaking, 1 is the easiest verse; 7941 is the most 
complex verse. You enter the minimum and maximum complexity values of the verses to 
display. Here are some examples: Enter 1 and 10 to display the first 10 easiest verses. Enter 
100 and 104 to display the 100..104th easiest verses. Enter 100 and 100 to display only the 
100th easiest verse. 

Select Highlighted Items in {Verse List, Word List, Lexical Word List, Grammar List} 
Selects the highlighted items in a non-active list as if you made the selections. To 
demonstrate, click a verse in the Verse list and then choose the Select Highlighted Items in 
Word List command. 



 

 

(More) 

Capitalized Lexical Words 
Selects lexical words in the Lexical Word List that start with a capital letter (e.g. proper nouns). 
Report 40 is automatically chosen, unless the current report is 00 (None). 

Lexical Words Sharing SRNs/G/K numbers 
Selects lexical words in the Lexical Word List that share a SRN (or G/K number) with another 
lexical word. Report 40 is automatically chosen, unless the current report is 00 (None). 

Lexical Words with Multiple SRNs/G/K numbers 
Selects lexical words in the Lexical Word List that have more than one SRN (or G/K number). 
The word and grammar within a verse determines which SRN is applicable. Report 40 is 
automatically chosen, unless the current report is 00 (None). 

Words with Multiple SRNs/G/K numbers 
Selects words in the Word List that have more than one SRN (or G/K number). Report 30 is 
automatically chosen, unless the current report is 00 (None). 

SRNs/G/K numbers Not Used by GreekToMe 
Displays a list of SRNs (or G/K numbers) that are not used by GreekToMe (for a variety of 
reasons). One reason is because there are word variations among Greek manuscripts. The 
scholars who compiled the UBS Greek text had to choose from among those word variations 
and thus not every word documented by Strong was used in their final text. Another reason is 
that in a few cases the author ignored the SRN that Strong assigned to a high-frequency word 
and instead assigned to it the SRN of its parent word in favor of a larger lexical word group. 
Report 00 (None) is automatically chosen. 

Words with No Accents 
Selects words in the Word List that no accents. Report 30 is automatically chosen, unless the 
current report is 00 (None). 

Words with Multiple Acute Accents 
Selects words in the Word List that have more than one acute accent. Report 30 is 
automatically chosen, unless the current report is 00 (None). 

Words with Circumflex Accent 
Selects words in the Word List that have a circumflex accent. Report 30 is automatically 
chosen, unless the current report is 00 (None). 

Words with Coronis Mark 
Selects words in the Word List that have a coronis mark (which looks like a smooth breathing 
mark). Report 30 is automatically chosen, unless the current report is 00 (None). 

Words with Dieresis Mark 
Selects words in the Word List that have a dieresis mark. Report 30 is automatically chosen, 
unless the current report is 00 (None). 



 

 

Words with Elision 
Selects words in the Word List that have an elision, represented by an apostrophe after the 
last letter of the word. Report 30 is automatically chosen, unless the current report is 00 
(None). 

Words with Iota Subscript 
Selects words in the Word List that have an iota subscript. Report 30 is automatically chosen, 
unless the current report is 00 (None). 

Words with Smooth Breathing Mark 
Selects words in the Word List that have a smooth breathing mark. Report 30 is automatically 
chosen, unless the current report is 00 (None). 

Words with Rough Breathing Mark 
Selects words in the Word List that have a rough breathing mark. Report 30 is automatically 
chosen, unless the current report is 00 (None). 

Reorder Preset Report Buttons 
Reorders the preset report buttons by ascending report number. 

Resize Window to Minimum 
Resizes the window to the smallest size in which the components can be arranged. 

Reset “Don't Show This Again” messages 
Causes all dialogs in which the “Don't Show This Again” button was clicked to appear again. 

Default Report Spacings… 
Restores only the report spacings to their defaults. 

Default Settings (all)… 
Restores everything (colors, book names, fonts, preset report buttons, etc.) to its default. 
“Don't Show This Again” messages are reset independently. 



 

 

Font 

Font Settings… 
Font and font sizes used for lists and reports, and what to substitute for eta and omega when 
transliterated. If accented characters appear as boxes, try setting the Greek fonts in the Font 
Settings dialog to Arial or Times for OS X, or Palatino Linotype for Windows. As a last resort, 
you might consider turning off accents (see Greek Accents option above) if the font you want 
to use does not display accented characters properly. 

Jumbo Report Fonts 
If checked, font sizes used for reports are increased by the Jumbo Report Fonts amount set in 
the Font Settings dialog. One idea is to turn on Jumbo Report Fonts for viewing a report, and 
to turn off Jumbo Report Fonts before printing a report. (The maximum font size appears to be 
127 points.) 

Super-Jumbo Report Fonts 
Like the Jumbo Report Fonts option, this is another means of instantly increasing the font sizes 
used for reports. This is great for giving demonstrations or giving your eyes a rest. 

Smaller Report Font Sizes 
Equivalent to choosing the next smaller font sizes for the Report Font and Report Font (Greek) 
fonts in the Font Settings dialog. 

Larger Report Font Sizes 
Equivalent to choosing the next larger font sizes for the Report Font and Report Font (Greek) 
fonts in the Font Settings dialog. 



 

 

Options 

Transliterate 
If checked, Greek letters are transliterated; by default, h (eta) is displayed as ē and w (omega) 
as ō. If desired, you can replace ē and ō with other characters in RTF reports using your word 
processor. However, those characters may display differently on another computer. You can 
decide what to substitute for h (eta) and w (omega) in the Font Settings dialog. If Transliterate 
is unchecked, Greek letters are displayed in the chosen Unicode font. 

Modern (Transliteration) Format 
If unchecked, the transliteration format is that used in Strong’s Exhaustive Concordance by 
James Strong, S.T.D., LL.D. 1890. If checked, the transliteration format is that described by 
http://www.loc.gov/catdir/cpso/romanization/greek.pdf. Here is a brief comparison: 
 

Greek word Changes Strong’s Exhaustive 
Concordance 

Modern Transliteration 
Format 

autoV (no change due to 
au diphthong) 

autos autos 

euge (no change due to 
eu diphthong) 

euge euge 

hulizeto (no change due to 
hu diphthong) 

ēulizeto ēulizeto 

oude (no change due to 
ou diphthong) 

oude oude 

uios (no change due to 
ui diphthong) 

uios uios 

MwushV 
(u has dieresis) 

(no change due to 
u dieresis) 

Mōusēs Mōusēs 

osfui 
(i has dieresis) 

u to y osphui osphyi 

suggeniV u to y, gg to ng suggenis syngenis 
sugkelei u to y, gk to nk sugkelei synkenis 
larugx u to y, gx to nx larugx larynx 

splagcna gch to nch splagchna splanchna 
UmeniouV u to y Humenious Hymenious 

Greek Accents 
If checked, Greek words are displayed with their accent and breathing mark(s). If unchecked, it 
is possible for Greek words that differ only by their marks to appear multiple times in reports 
30..36 and in the Word List because from the software program's perspective, the words are 
different! If unchecked, you should consider checking the Auto-Highlight Similarly-Spelled 
Words with Same Lexical Word option. Some fonts do not display [extended] Unicode 
characters properly. One useful reason for temporarily turning off Greek accents is when 
searching the report area for a sequence of non-accented Greek letters (by pressing F2 or F3) 
and you don't don't want the accents and breathing marks to affect your search. 



 

 

Greek Punctuation 
If checked, punctuation [suggested by Greek scholars] is added to Greek verses displayed in 
the report area. Punctuation is an option because the Greek manuscripts did not contain 
punctuation. Don't feel bad about adding the punctuation; remember that the Greek 
manuscripts also didn't have chapter/verse divisions! 

Greek Syllables 
If checked, syllables of Greek words are revealed. In GreekToMe, syllables reveal compound 
words and aid pronunciation. You can change the syllable separator in the Font Settings 
dialog. 
 
The compound Greek word eiserchomai (SRN 1525) is divided as eis-er-cho-mai, not ei-ser-
cho-mai. Aim to sound the 's' on the first syllable, but expect the 's' to slur into the second 
syllable. 
 
Some syllables begin with sounds like pt, kt, fq, or cq. If after practicing you still struggle with 
a particular consonant cluster, try pronouncing its first consonant at the end of the prior 
syllable. For example, try bap-ti-zo-mai instead of ba-pti-zo-mai; they sound almost the same 
when spoken at normal speed. 
 
The smooth-breathing “I” in I-ou-da and I-e-za-bel is pronounced “You-da” and “Ye-za-bel”. 
 
Lastly, syllables of proper names (e.g. people, places) sometimes differ from the norm. 

Auto Scroll Lists 
If checked, automatically scrolls the lists to reveal the first highlighted item in each list. You 
may want to temporarily uncheck this when entering many verses in the Verse field. 

Long Book Names 
If checked, the books of the Bible used in reports are not abbreviated (such as 
1 Thessalonians instead of 1Thes). This, of course, is good for printing verses for people who 
are new to the Bible. 

More Compact Grammar 
If checked, tiny parsing codes (e.g. pt.fa.nsm) rather than abbreviated words (e.g. nom. sg. 
m. fut. act. part.) are displayed in reports that display grammar. The order of the Grammar 
List is determined by the state of this menu item when the program is launched. The parsing 
codes are very similar to those used in the NIV English-Greek New Testament: a reverse 
interlinear / edited by William D. Mounce. 

Use C instead of X key for letter Chi 
If checked, typing c will enter Greek letter c and typing x will enter Greek letter x, in the Word 
or Lexical word fields, and in the Build-A-Word dialog. If unchecked, typing c will enter Greek 
letter x and typing x will enter Greek letter c. Although x and c look very similar, this option is 
provided because when transliterating, c is similar to its transliterated ch (e.g. cristoV = Christ) 
and x is sounds like its transliterated letter x. (e.g. ex = ex). 



 

 

Use Superscripts, not Subscripts 
If checked, places in the program that use subscript digits (e.g. Report 09 and the Build-A-
Word dialog) will instead display superscript digits. Not all (Greek) fonts display all 10 
superscript digits consistently. Two fonts that display them correctly are Georgia Greek and 
Palatino Linotype. Use the Unicode “Palette” command to sample both the superscript and 
subscript digits in the current Greek report font. 

Show SRN/G/K in Lists 
If checked, the Strong’s Reference Number (SRN) or Goodrick/Kohlenberger (G/K) number for 
each word and lexical word is displayed in the Word List (letter I) and Lexical Word List (letter 
J) respectively. 
 
The lexical words used by GreekToMe are those found in the Greek New Testament source. A 
few words in GreekToMe (e.g. emoi emoi) display more than one SRN. When doing research 
involving these words, the user must discern the applicable SRN by a lexicon and/or the 
context of the verse. In reports that show a word in the context of a verse, GreekToMe can 
determine which one of the multiple SRNs is applicable and only display that SRN. Much care 
has gone into typing the SRN and G/K numbers into the program; any mistakes are 
unintentional. 

Show SRN/G/K in Reports 
If checked, the Strong’s Reference Number (SRN) or Goodrick/Kohlenberger (G/K) number for 
each lexical word is displayed in reports that display lexical words. 

Show Frequency in Description 
If checked, the frequency is included In the description (letter M) when clicking a Greek word 
or lexical word in the report area (letter R). When a Greek word is clicked (as opposed to a 
lexical word), the word frequency (W, ignoring accents) is displayed in addition to the lexical 
word (LW) frequency in the form “ : W of LWx”. If LW is 1, “ : 1x” is displayed instead of “1 of 
1x”. 

Show Frequency in Reports 
If checked, the total number of occurrences of words in the Greek New Testament represented 
by the lexical word is included in the form “ : #x” in reports that display a dictionary entry. 

Show Print Page Width 
If checked, overlays a light gray line where the lines of text in the report area are expected to 
break when printing. 

Collapse Translation Notes as ⸋ 
If checked, each note in the translation text is “collapsed” and represented in the report area by 
a raised square (⸋) symbol. If you hover the mouse pointer over a raised square in the report 
area, the mouse pointer will change to a hand and the translation note will momentarily be 
displayed. If you click the mouse on a raised square, the translation note will be displayed in a 
dialog. Clicking the “Expand Translation Notes” button in the dialog is the same as unchecking 



 

 

this menu item. Not all translation files contain notes. (This option does not affect dictionary 
notes in the report area, which are always displayed as expanded.) 

 ... Use Numbers instead of ⸋ 
If checked, instead of a raised square (⸋) symbol, each “collapsed” translation note is assigned 
a number. Also, the translation notes are displayed near the bottom of the report area, prior to 
any copyright notices. If the Report Spacing is Triple-Spaced or greater then the translation 
notes are double-spaced in the report area, otherwise they are single-spaced. (This feature 
applies when Collapse Translation Notes as ⸋ is checked.) 

Include Highlighted Verse References 
If checked, each translation note listed in the report area will be followed by " -- " and verses 
[that are highlighted in the Verse List] that use that translation note. (This feature applies when 
both Collapse Translation Notes as ⸋ and Use Numbers instead of ⸋ are checked.) 

Minimize Translation Note Numbers 
If checked, identical translation notes are combined into a single translation note number. Two 
translation notes are identical if they have the same case-sensitive note text and the same text 
style. (This feature applies when both Collapse Translation Notes as ⸋ and Use Numbers 
instead of ⸋ are checked.) 

Sort Translation Notes 
If checked, the translation notes listed in the report area are sorted (case-insensitive) by their 
note text instead of their translation note number. This causes the translation note numbers to 
be out of order, and so its only purpose is for reviewing and comparing the translation notes. 
(This feature applies when both Collapse Translation Notes as ⸋ and Use Numbers instead 
of ⸋ are checked.) 

Search Translation/Dictionary Notes 
If checked, notes (i.e. words within braces { }) in a translation or dictionary file are included 
when searching the current translation or dictionary. For example, if checked, searching the 
current translation for “my always” would find this verse: 
 
1Thes 5:16 Rejoice{This is my translation note.} always,  
 
and searching the current dictionary for “my” would find this dictionary entry: 
 
2000 dangerous {This is my dictionary note.} 

Indent Reports 21..25 
If checked, inserts leading spaces in reports 21..25 based upon word grammar as shown: 
 

Conjunction  (the indention is exaggerated here for documentation purposes) 
     Verb 

            Adverb 
                 Particle 
                      Preposition 



 

 

                           Article or Interjection 
                                Noun or Pronoun 
                                     Adjective 

Minimize Accents in Report 72 
If checked, and multiple words having the same lexical word and non-accented spelling would 
share a cell in a paradigm chart, the word with the fewer number of acute/grave accents is 
displayed. If the number of acute accents equals the number of grave accents, the word with 
the acute accent is displayed. 

Display 3 John 1:2 as 3 John 2 
If checked, the chapter is suppressed if the book has only one chapter. 

Larger Report Area 
If checked, the lists are shortened (the Author List is completely hidden) to make room for a 
taller report area. You may also click the Author label (letter E) to change this setting. 

Append Translation Name 
If checked, and the translation name is KJV for example, “ (KJV)” is appended to each verse of 
the translation when displayed in the report area. 

Append Copyrights 
If checked, and a COPYRIGHT line was found in the current translation, and the report 
contains references from the translation, then the copyright notice is displayed at the bottom of 
the report. If the report displays Greek text then its copyright is also displayed. 

Verse Field Adds To Verse List 
If checked, when you enter a verse in the Verse field (letter BB), the verse is added to the 
Verse List (letter H) instead of first clearing all lists. If checked, and no verses are currently 
highlighted, a “+” will appear in the label above the Verse field. If you click the Verse label 
(letter B), a small dialog will appear as another way to change this setting. 

Word Field Adds To Word List 
If checked, when you enter a word in the Word field (letter CC), the word is added to the Word 
List (letter I) instead of first clearing all lists. If checked, and no words are currently highlighted, 
a “+” will appear in the label above the Word field. If you click the Word label (letter C), a small 
dialog will appear as another way to change this setting. 

Lexical Word Field Adds To Lexical Word List 
If checked, when you enter a lexical word in the Lexical Word field (letter DD), the lexical word 
is added to the Lexical Word List (letter J) instead of first clearing all lists. If checked, and no 
lexical words are currently highlighted, a “+” will appear in the label above the Lexical Word 
field. If you click the Lexical Word label (letter D), a small dialog will appear as another way to 
change this setting. 

Auto-Highlight All Other Words having Same Lexical Word 
If checked, when you click one word in the Word List, all other words derived from the same 
lexical word will also be highlighted in the Word List. 



 

 

Auto-Highlight Similarly-Spelled Words having Same Lexical Word 
If checked, when you click one word in the Word List, words that are spelled the same 
(ignoring accents) and share at least one Lexical word will also be highlighted in the Word 
List. 

Include `Keyboard` Text in Reports 30..38 
If checked, the letters to type on a keyboard to search for the Greek word that appears below it 
are included within back quotes. Therefore, if report 30..38 is saved to a file, and that report is 
searched outside of GreekToMe (e.g. an e-reader), you can search using the same letters as 
you would use to find the Greek word in the Word list. For example, Dauid is David, and can 
be found in the file by searching for `dauid`. The back quote (`) character before and after the 
word help you search for a particular tiny word, like `de` for de. 

Include Percentage in Reports 34, 46, 51, 52 
If checked, the percentage of the number of times an author used a highlighted Greek word 
(reports 34 and 51) or highlighted lexical word (reports 46 and 52) is included with respect to 
the total count of all the Greek words the author wrote. This reveals a different 
perspective…how much an author used a Greek word or lexical word in comparison with how 
much of the New Testament they wrote. If checked, the statistics in Reports 34 and 46 are 
sorted by descending percentage rather than the number of times. If you choose Report 46 
and type kai and press the return key in the Lexical Word field, you will see in the statistics 
that even though Luke has the highest count (2579 times), almost 10% (9.649%) of the words 
in the book of Mark are word(s) whose Greek lexical word is kai. 

Show 'Convert to Translation Note with References' Result 
If checked, the result of the "Convert Selected Report Text to Translation Note in Clipboard 
with References" command is displayed in a dialog after it is copied to the clipboard. As 
explained earlier, you might find two sets of braces {…}{…} in the clipboard. If so, the left-most 
set of braces is more readable to a person, whereas the right-most set is the HTML-compatible 
translation note that is compatible with a GreekToMe translation file. The left-most set of 
braces is what is displayed in the dialog. This option is provided in order to view [at least a 
portion of] the result of the "Convert … with References" command in the clipboard without 
having to paste it somewhere. 



 

 

Colors 
The menu items available under this menu may be used to change certain colors used by the 
program. The table below shows each area (in red) that can be customized by the Colors 
menu. Choosing a Preset Color Scheme (or Default Look & Feel Color Scheme) changes all 
these colors. 
 

Window Background 

 

List Background 

 

Highlighted List Items 

 

Selected List Items 

 

Description Background 
 

Description 
 

Highlighted Report Items 
 

Collapsed Note  
Checklist Checkmark  

Import Colors… 
Reads color settings from a file and applies them to the program. 

Export Colors… 
Write the program's current color settings (Window Background color through Collapsed Note 
color) to a file. 



 

 

Look & Feel 
If you have spent time customizing the colors in the program, use the Export Colors command 
to save your custom colors so you can restore them later (if desired) using the Import Colors 
command. 
 
The menu items available under this menu depend on your operating system. They control the 
look of the graphical components of the program. If you choose Aero, Bernstein, HiFi, Luna, 
McWin, Mint, or Smart, the program automatically does the Default Look & Feel Color Scheme 
command. For some reason this does not always result in the correct colors, and so you will 
be reminded to re-launch the program. If you didn't do an Import Colors command after 
choosing one of those look and feels, the Default Look & Feel Color Scheme command will 
again be done automatically the next time you re-launch the program. 

Language 
This hierarchical menu contains menus and menu items based upon language translations 
contained inside the program, plus optional files found in the internationalization folder when 
the program is launched. When a language menu item is chosen, the associated language file 
is read, and the Clear button is automatically clicked. See the “Internationalization” section in 
this document for details. 

Screen Menu Bar (Macintosh only) 
If checked, the program's menu bar will be displayed at the top of the screen when the 
program is re-launched. Also, the current Look & Feel must be Mac OS X. Otherwise, the 
menu bar is in the program's main window. Requires Java 1.5 or later. 

Window 
Besides the menu items described below, the Window menu also maintains a menu item for 
each open window which if chosen brings that window to the front. Choose the History menu 
item to (show and) bring the History window to the front. 

Detach Report & Refresh 
Moves the content of the report area into a new window and then refreshes the report area. 
Although you can make changes to a detached report, it is primarily for viewing since you can't 
print or save a detached report window from within the program. 

Detach Report 
Save as above, but doesn't refresh the report area. 



 

 

Help 

About GreekToMe… 
Displays program version information. 

Check for Update 
This command (which requires an Internet connection) asks the GreekToMe web site if a later 
version of the program is available, and optionally download it. For installations that want 
stricter version control and prefer their users not to update on their own, contact the author for 
how to disable this menu item. 

GreekToMe News 
Displays the GreekToMe News web page in your browser for information about recent 
releases. 

GreekToMe Welcome 
Displays the welcome message in the report area. 

GreekToMeLite for Android™ 
Displays the GreekToMeLITE web page in your browser. GreekToMeLITE is a simplified 
version of the GreekToMe program. See Section 18 in this document for (optional) technical 
details. 

Demonstrate 
Demonstrates some of the features of the program while you watch. 

Quick Reference… 
A quick reference for entering search text, a verse, word, lexical word or Strong’s Reference 
Number (SRN). If you are new to Greek and don't have any Greek reference books, the 
definitions and examples will help introduce you to the grammar terms used in the program. If 
the current language code is not “en” (English), GreekToMe first tries to load and display a file 
called xxQuickReference.htm in the internationalization folder where xx is the current 
language code such as frQuickReference.htm for “fr” (French). 

Accents 
Displays in the report area each accented Greek letter in the Greek New Testament, its 
number of occurrences, followed by a word and verse (preferably in Hebrews or Luke) in which 
it can be found. 

Grammers 
Displays in the report area a list of the grammar abbreviations and terms. 

HTML Codes 
Displays in the report area the alphabetical (e.g. &eacute;) HTML escape codes supported by 
the program and what the characters they produce look like in the fonts chosen in the Font 
Settings dialog. See the “Internationalization” section in this document for details. 



 

 

Language and Country Codes 
Displays in the report area the Java language codes and country codes available on the 
workstation. See the “Internationalization” section in this document for details. 

Idioms 
Displays in the report area some idioms found in the Greek New Testament. These are the 
same idioms as in the Quick Reference except that their meanings are translated for the 
current language. 

Square of Stops 
Displays in the report area how consonants combine with sigma and theta. 

Unicode “Palette” 
Displays in the report area the Unicode characters available in the Build-A-Word dialog (F1 
key). This can be used to visually test a Unicode font (that has Greek Extended characters), 
or, the characters can be copied and pasted into your Unicode-compatible editor to build 
words, etc. 

Verb Contractions 
Displays in the report area how vowels combine in verbs, along with an example of each 
combination. 

Lexical Word Frequency 
Displays in the report area the descending number of occurrences of each lexical word along 
with its dictionary entry. Lexical word frequency is the total number of times the Greek words 
related to a lexical word are used in the Greek New Testament. Below the lexical word 
dictionary entry, you will see each related Greek word along with its own frequency in 
parentheses; a frequency of one “(1)” is not shown. If desired, you can enter a number so that 
only those words having that (or higher) word frequency are included. For example, enter 10 to 
include related words whose frequency is 10 or more times. Leave the field empty and click 
OK to include all related words. Hint: Before choosing the Lexical Word Frequency command, 
change the report to 00 (None) and the Report Spacing to the desired number of extra lines 
(e.g. Double-Spaced). 
 
If you are serious about memorization, the author highly recommends the book Complete 
Vocabulary Guide to the Greek New Testament (Revised Edition) by Warren C. Trenchard. 
The book has memorization aids far beyond the scope of the GreekToMe program. 

Only Undefined (“?”) Definitions 
Displays only definitions that are not yet defined (useful for someone developing a dictionary). 

Word Frequency 
Displays in the report area the descending number of occurrences of each accent-specific 
Greek word in the Greek New Testament. Knowing the meaning of the Greek words shown on 
the first few pages of the 50+ report will enable you to read much of the Greek New 
Testament! If you don't recognize the Greek word, perhaps the Lexical Word(s) column will 
give you a hint. Before displaying a word frequency report, consider choosing a dictionary with 
short definitions (such as the Built-In dictionary). 



 

 

Read GreekToMe.pdf 
This menu item is enabled if the GreekToMe.pdf exists in the same folder as the 
GreekToMe###.jar (Java) application. Choosing this menu item attempts to launch an 
application that can open the document. If the current language code is not “en” (English), 
GreekToMe first tries to open a document file called xxGreekToMe.pdf in the 
internationalization folder where xx is the current language code such as frGreekToMe.pdf 
for “fr” (French). 



 

 

5. Entering Verses 
 
The book name does not need to be followed by a space (e.g. matt1 14), but a space is shown 
in these examples for easier reading (e.g. matt 1 14). To separate the chapter and verse you 
may use a space, colon, semicolon, or comma. 
 
Enter matt 1:14 or m 1 14 in the Verse field (letters BB) to select Matt 1:14 in the Verse List. 
 
Enter john or j to select John 1:1 in the Verse List. 
 
Enter mar 5 34 to select Mark 5:34 in the Verse List. 
 
Enter 1p 2 24 to select 1Peter 2:24 in the Verse List. 
 
Enter m 8 to select all of Matthew Chapter 8. 
 
Enter m 8 16-18 to select Matthew Chapter 8 Verses 16 through 17. 
 
Enter m 1-5 to select the first 5 verses of Matthew Chapter 1. 
 
Bonus Information 
 
If you remembered that a verse was 1:14 but you couldn’t remember what book, use any or * 
as the book name as in any 1:14. That will select Chapter 1 Verse 14 in all books that have 
such a verse. 
 
Enter any 1:1-3 to select Chapter 1 Verses 1, 2, and 3 in all books. 
 
If you don't separate the chapter and verse (with a space, colon, semicolon, or comma), the 
program will try to figure out what chapter and verse you mean. For example: 
 
Enter ju 1 to select all of Jude Chapter 1. 
 
Enter ju 12 (or ju 1 2) to select Jude Chapter 1 Verse 2. 
 
Enter ju 122 (or ju 1 22) to select Jude Chapter 1 Verse 22. 
 
Enter m 12 to select all of Matthew Chapter 12. 
 
Enter m 1 2 to select only Matthew Chapter 1 Verse 2. 
 
Enter m 123 to select Mathew Chapter 1 Verse 23. Notice here that the program can't tell 
whether you meant Matt 1:23 or Matt 12:3 so it selects the verse with the lowest chapter (Matt 
1:23). For Mathew 12 Verse 3 you would have to enter m 1203 (or m 12 3). 
 



 

 

6. Entering Search Text 
Enter one or more words in the Search field (letters GG) and press the return key to search 
the current translation, or press F9 to search the current dictionary. The order of the words 
you enter matters because words you enter are matched from left to right in the verse. In other 
words, “holy spirit” and “spirit holy” will not find the same verses. You don’t need to enter any 
capital letters because searches are case-insensitive. An asterisk may be used at the end of a 
word to indicate, “starting with”. Here are some examples of how words would match (these 
examples are from the NAS translation): 
 

If you entered… What words would match? What words would not 
match? 

mother mother 
mother’s 
mother-in-law 

 

mother’s mother’s mother 
mother-in-law 

mother-in-law mother-in-law mother 
mother’s 

cent* cent 
cents 
center 
centurion 
centurions 
centurion’s 

 

 
In addition to what is described above, you can add a relational operator between your search 
phrases. Special operators do not work when searching the report with the F2 and F3 keys. 
 

Relational Operator Meaning 
+ “and” 
&  ( same as +) “and” 
| “or” 
~  ( by the 1 key) “excluding” 

 
Relational operators are processed left to right so that a | b & c ~ d is processed as ((a | b) & 
c) ~ d and could be read “a or b, and c, excluding d”. This would find verses containing phrase 
a or b, retain those that contain c, and exclude those that contain d. Examples: 
 

Search Text Find verses containing… 
on the water “on”, “the”, and “water” in that order. 
on + the + water “on”, “the”, and “water” 
on & the & water same as previous example 
camel | rich “camel” or “rich” 
temple + phar* “temple” and word beginning with “phar” 
holy ~ spirit “holy” but excluding “spirit” 
peter's ho* mother “peter's”, a word beginning with “ho”, and 

“mother” in that order 
(e.g. Matt 8:14 in KJV, BBE, and WEBible) 



 

 

7. Entering Greek Letters 
 
Type this…  To produce this Greek 

letter 
How transliterated in GreekToMe 

a a alpha a 
b b beta b 
g g gamma g 
d d delta d 
e e epsilon e 
z z zeta z 
h h eta ē  (customize in Fonts dialog) 
q q theta th 
i i iota i 
k k kappa k 
l l lambda l 
m m mu m 
n n nu n 
x x xi x 
o o omicron o 
p p pi p 
r r rho r 
s, V s, V sigma s 
t t tau t 
u u upsilon u 
f f phi ph 
c c chi ch 
y y psi ps 
w w omega ō  (customize in Fonts dialog) 
= = (apostrophe) ‘ 

The Build-A-Word dialog makes entering Greek letters easy! (Press F1 in the program.) 

Note: You don't need to enter accented Greek letters in the Word or Lexical Word fields.



 

 

8. Setting Grammar Attributes 
Click the Set Grammars… button (letter FF) to invoke a dialog to easily select items in the 
Grammar List. Each time you check or uncheck a checkbox, you will see the number of words 
in the Greek New Testament that match your settings. In the following picture 36 words match 
the criteria Verb 1st Person Singular Aorist Middle. Because the popup at the bottom of the 
dialog is set to All, all the criteria checked must be an attribute of matching words. You can 
click the Previous button to restore the checkbox settings to what they were the last time you 
clicked the OK button. 
 

 
 
Grammar Attributes Trick: This usually isn't useful for searching, but if you want the program to 
turn on all the applicable checkboxes represented by the current Grammar List so you can see 
the attributes at a glance, hold down the Shift key and click the Set Grammars button. 



 

 

9. Memory Set Operations 
This only sounds complex. It’s not complex once you try a few examples. It’s like using 
memory functions on a calculator. 

What is a set? 
Remember set theory in math class? Just think of a set as a collection of things. In our case, a 
set is a collection of books, verses, words, lexical words, authors and grammars of the New 
Testament. 

Union of sets 
Suppose one set contained all the verses written by Luke. Suppose another set contained all 
the verses written by John. The union of those sets would result in all the verses written by 
Luke plus all the verses written by John. Therefore the union would comprise the following 
books of the New Testament: Luke, John, Acts, 1John, 2John, 3John, Rev. A union is 
performed by clicking the M+ button. Hold down the Shift key and click the M+ button to 
automatically perform the MC function before the M+ function. 

Subtraction of sets 
Suppose one set contained all the verses written by John. Suppose another set contained all 
the verses of Revelation. The subtraction of those sets would result in all the verses written 
by John minus all the verses all the verses of Revelation. Therefore, the subtraction would 
comprise the following books of the New Testament: John, 1John, 2John, 3John. A subtraction 
is performed by clicking the M- button. 

Intersection of sets 
Suppose one set contained all the verses having a word derived from the lexical word agioV 
(agios; holy). Suppose another set contained all the verses having a word derived from the 
lexical word pneu:ma (pneuma; spirit). The intersection of those sets would result in all the 
verses having a word derived from the lexical word agioV (agios; holy) and having a word 
derived from the lexical word pneu:ma (pneuma; spirit). An intersection is performed by clicking 
the Mx button. 

Recalling the set stored in memory 
To recall the set stored in memory, click the MR button. Or, you can double-click the memory 
in the “Memories” area of the History window to (change and) recall the memory set. If the MR 
button is disabled it means that the set is empty. 

Intersection — an example 
1. Click in the Lexical Word field (letter DD) and type agios. 
2. Click the M+ button. 
3. Click the Clear button (letter T). 
4. Click again in the Lexical Word field (letter DD) and type pneuma and press return. 
5. Click the Mx button. 
6. Click the MR button. The verses displayed in the Verse List (letter H) are all the verses 

having a word derived from the lexical word52agioV (agios; holy) and having a word 
derived from the lexical word pneu:ma (pneuma; spirit). 



 

 

7. Note: MR does not clear the set stored in memory. Until you click the M+, M-, Mx, MC, 
or quit the program, clicking MR will continue to recall the results of Step 6. 

Emptying the set stored in memory 
The union, subtraction, and intersection functions are performed against the set you stored in 
memory. To clear the set stored in memory, click the MC button. If the MC key is disabled, the 
current memory is already cleared (but not necessarily the other memories). When the MC 
button is enabled, you can hold down any modifier key and click the MC button to clear all 5 
memory sets. 

Changing the current memory set 
The popup to the right of the MR button determines which memory to use for subsequent 
memory operations. Or, you can single-click the memory in the “Memories” area of the History 
window to change the memory set. Though some users may find using the memories 
confusing, others will use it to save intermediate results for later recall. To save results, choose 
a memory set (1..5) from the popup and click M+. To recall results, choose a memory set (1..5) 
from the popup and click MR. 

Copying memory 1 to current memory set 
You will see the M1^ button if there is something stored in memory set 1, and the current 
memory set is not 1. Click M1^ to copy the contents of memory set 1 to the current memory 
set. Conversely, hold down any modifier key† and click the the M1^ button to copy the 
contents of the current memory set to memory set 1. Note that unless you have have clicked 
MR to recall the contents of the current memory, what you are copying might not be what you 
are currently looking at in the various lists. 

Searching for Greek word patterns 
The 123 button uses the highlighted Words stored in two or more memories to search for 
Greek word patterns within all verses. Suppose you wanted to find all verses that contained all 
words having a grammar of perfect passive participle (perf. pass. part.) followed by any word 
having a lexical word of oujranovV (ouranos; heaven). Do these steps to try it: 
 

1. Click the Set Grammars button (letter FF). 
2. Turn on the Perfect, Passive, and Participle checkboxes. 
3. Click the OK button. 
4. Choose memory set 1 from the popup (near letter P) and click MC if it is available, then 

click M+. 
5. Click the Clear button (letter T). 
6. Click in the Lexical Word field (letter DD). 
7. Enter ouranos and press return. (i.e. SRN 3772) 
8. Choose memory set 2 from the popup (near letter P) and click MC if it is available, then 

click M+. 
9. Click the 123 button. The dialog that appears confirms your search criteria. If you have 

words stored in more than two memories, you can decide which memories you want to 
use. 

10. Click the Search button. It should find 13 verses. 
 



 

 

The optional Search width field limits the number of consecutive Greek words in which your 
search must match. If you enter a positive value, but that value is less than the number of 
memory checkboxes that are turned on, the program will automatically substitute the number 
of memory checkboxes that are turned on because otherwise a match would be impossible. 
 
Note: You may want to turn on the “Auto-Highlight Similarly-Spelled Words with Same Lexical 
Word” option before selecting words in the Word List, unless you are searching for words with 
particular accents. 
 
To try the (sophisticated) “Match words in Memory __ and __ must share a lexical word” 
option: 
 

1. Select “Highlight Everything!” from the Search menu, and click the “No” button for 
Report “00:  None”. 

2. Choose memory set 1 from the popup (near letter P) and click MC if it is available, then 
click M+. 

3. Choose memory set 3 from the popup (near letter P) and click MC if it is available, then 
click M+. 

4. Click in the Lexical Word field (letter DD). 
5. Enter anti and press return. (i.e. SRN 473) 
6. Choose memory set 2 from the popup (near letter P) and click MC if it is available, then 

click M+. 
7. Click the 123 button. 
8. In the Greek Word Pattern Search dialog, ensure (only) the Memory 1, 2, and 3 

checkboxes are turned on. 
9. In the Optional Additional Criteria area, turn on the “Match words in Memory 1 and 3 

must share a lexical word” checkbox, and enter a Search width of 3 words. 
 
Click the Search button. It should find the 5 verses in the Greek New Testament that contain 
any Greek word; followed by lexical word anti; followed by a Greek word having the same 
lexical word as the first matching word. Select a report to view the 5 verses, such as Report 
13. In the translation, you should see phrases like “eye for an eye”, “grace upon grace”, and 
“evil for evil”. 
 
Note: Special word highlighting is done in the Report area (letter R) when you search using the 
123 button, in order to more easily see the Greek words that matched the pattern. This special 
word highlighting happens for Reports 09, 10, 13..16, 21..26, and 82, and persists until you 
click the the MR button, or do something that causes any of the lists to change. 

Saving and Loading the Memories 
Use the Export Memories and Import Memories commands in the File menu.  
 
Note: Future versions of the program may not be able to import your existing memory files, so 
consider them expendable. 
 



 

 

10. The History Window 
What is it? 
The History window keeps track of the changes you've made to the program's lists, and to the 
memory sets, so you can easily recall them and “go back” to a prior state. 

How do I invoke it? 
If the History window is not open, or it is hidden behind another window, choose the History 
menu item from the Windows menu to bring it to the front. If the History window is open when 
you quit the program, it will be opened (behind the main GreekToMe window) when the 
program is launched. 

What is the History area? 
The upper portion of the History window is labeled “History” and displays the descriptions of 
the last 8 unique sets of items highlighted in the Book, Verse, Word, Lexical Word, Author, and 
Grammar List. As you make changes that affect the items highlighted in the program's lists, the 
corresponding description (letter M) is copied to the “History” area of the History window. The 
most recent history item is always at the top. The previous history item is just below that, etc. 
Double-click a description in the History area to recall its highlighted list items. Click the Clear 
button to the left of the “History” label to clear all the items in that area. 

What is the Memories area? 
The lower portion of the History window is labeled “Memories” and displays the descriptions of 
the 5 memories (1, 2, 3, 4, 5). As you make changes to a memory set, the corresponding 
description (letter M) is copied to the “Memories” area of the History window. Double-click a 
description in the “Memories” area to (change the current memory set) and recall its 
highlighted list items. Single-click a description in the Memories area to change the current 
memory set without recalling it. Click the Clear button to the left of the “Memories” label to 
clear all 5 memory sets. 

Saving the History window contents 
The information associated with the History window is automatically saved (in a compressed 
binary format) in the GreekToMe.ini file when you quit the program (except if you use the “Quit, 
Don't Save Settings” command). If you don't want any history stored, click both Clear buttons 
in the History window before quitting the program. 

Loading the History window contents 
The last saved information associated with the History window is automatically loaded from the 
GreekToMe.ini file when you launch the program. The History window data is stored 
separately for each UBS version. If a future version of the program cannot load the last saved 
information, the History window will be cleared, but it should load on launch from them on. 



 

 

How does it work? 
Here are a few simple steps that demonstrate the History window: 
 

Action Resulting description in 
“History” area of the 
History window 

Comments 

1. Click Matt 1:1 in Verse List. Verse: Matt 1:1 Matt 1:1 is the most recent description. 
2. Click Matt 1:2 in Verse List. Verse: Matt 1:2 

Verse: Matt 1:1 
Matt 1:2 is the most recent description. 
Matt 1:1 is the previous description. 

3. Click Matt 1:3 in Verse List. Verse: Matt 1:3 
Verse: Matt 1:2 
Verse: Matt 1:1 

Matt 1:3 is the most recent description. 
Matt 1:2 is the previous description. 
Matt 1:1 is the oldest description. 

4. Click Matt 1:1 in Verse List.  Verse: Matt 1:1 
Verse: Matt 1:3 
Verse: Matt 1:2 

Matt 1:1 is (again) the most recent description. 
Matt 1:3 is the previous description. 
Matt 1:2 is the oldest description. 

5. In the History window, 
double-click the “Verse: Matt 
1:3” description to recall those 
highlighted items. 

Verse: Matt 1:3 
Verse: Matt 1:1 
Verse: Matt 1:2 

Matt 1:3 is (again) the most recent description. 
Matt 1:1 is the previous description. 
Matt 1:2 is the oldest description. 

 Resulting description in 
“Memories” area of the 
History window 

 

6. Click the M+ button. 1: Verse: Matt 1:3  (13 
Words)  (Aram, …) 

The items highlighted by clicking Matt 1:3 (in 
step 3), and recalling them (in step 5), have 
been copied into memory 1. 

7. In the main GreekToMe 
window, click the Clear 
button. 

(no change) Nothing is selected/highlighted in any list in the 
main program window. 

 Resulting description in 
“History” area of the 
History window 

 

8. In the “Memories” area of 
the History window, double-
click the item for memory 1, 
which is the item that starts 
with “1:” 

Verse: Matt 1:3 
Verse: Matt 1:1 
Verse: Matt 1:2 

The items that were highlighted in step 6 are 
recalled. Since the highlighted items recalled 
match those of “Verse Matt 1:3”, there is no 
change in the “History” area. 

 
When determining the top item in the History area, the program first looks for an existing 
history item having identical highlighted items. If such an item is found, it is moved to the top. If 
none is found, a new item is inserted at the top. In either case, the top item takes on the 
latest description (letter M). 
 
When memory operations are involved, you may see the description of the top history item 
change to Union (due to M+), Subtraction (due to M-), or Intersection (due ot Mx). 

What happens to old history? 
There is storage for the last 8 unique sets of items highlighted in the program's lists. After that, 
the oldest history item at the bottom of the History area is discarded.



 

 

11. Translations 

About the Bible translations distributed with GreekToMe 
Except for the Bible in Basic English (BBE), the Bibles (written in English) that are distributed 
with GreekToMe are word-for-word translations. These more closely follow the Greek word 
order and therefore they work well alongside the Greek text. The non-English Bibles distributed 
with GreekToMe are what were available in the Public Domain. 

Can I supply my own translation? 
Yes. If you have access to a translation of the New Testament that you can export, you can 
create a translation file that GreekToMe can read. 

How do I start my own translation or Bible notes file? 
See the Create Starter Translation command in Section 4 of this document. 

Can I share my reports with others? 
If you haven’t already, read the Copyright and Permissions of Bible Texts paragraph in 
Section 1 of this document. 
 
Since some of the reports produced by GreekToMe may contain the text of a copyrighted 
translation you supplied, you are responsible for adding the appropriate copyright notices to 
those reports. If your translation file contains a COPYRIGHT line (see format below) and the 
Append Copyright menu item is checked, the copyright notice will be appended to applicable 
reports. Consult the copyright and permissions for the translations you use. 

What is the format for a translation? 
This is the format of each line of a text-only file: 
 
Book<space or tab>Chapter:Verse<space or tab>text of the verse<return> 
 
Example lines: 
John 1:1 In the beginning was the Word, and the Word was with God, and the Word was God. 
1Cor 1:3 Grace be unto you, and peace, from God our Father, and from the Lord Jesus Christ. 
Jude 1:2 Mercy unto you, and peace, and love, be multiplied. 
 
If only one number is found, Chapter 1 is assumed: 
Jude 2 Mercy unto you, and peace, and love, be multiplied. 
 
Unlike dictionary files, translation files do not support the /*…*/ format. 
 
A long dash (called an em dash) should be represented by two hyphens (--). A single hyphen 
will be treated as a hyphenated word only if the hyphen has a letter (a..z) before and after it as 
in “mother-in-law”. 
 
Although you can change the abbreviated and unabbreviated names of books displayed in the 
program, you must use the following book names in the translation file: Matt, Mark, Luke, 



 

 

John, Acts, Rom, 1Cor, 2Cor, Gal, Eph, Phil, Col, 1Thes, 2Thes, 1Tim, 2Tim, Tit, Phlm, Heb, 
Jas, 1Pet, 2Pet, 1John, 2John, 3John, Jude, Rev. 
 
To specify a copyright notice for the translation, begin any line (e.g. the first line of the file) with 
COPYRIGHT: followed by copyright notice such as: 
COPYRIGHT:This is the Copyright &copy; notice I want to appear in 
applicable reports. 
 
In v6.2.0, support was added for HTML escape codes in the COPYRIGHT: line, such as 
&copy; to produce a Unicode copyright symbol. 
 
In v5.7.9, support was added to display italics within a verse using <i> to toggle italics on or 
off. Here is an example from the LITV: 
 
Matt 5:5 Blessed <i>are<i> the meek! For they shall inherit the 
earth. <i>{Psa. 37:11}<i> 
 
which displays in the program: 
 
Matt 5:5 Blessed are the meek! For they shall inherit the earth. 
{Psa. 37:11} 
 
You may use </i> but GreekToMe treats </i> just like <i> and therefore </i> also means 
toggle italics on or off: 
 
Matt 5:5 Blessed <i>are</i> the meek! For they shall inherit the 
earth. <i>{Psa. 37:11}</i> 
 
See the Internationalization section for information on how to use HTML escape codes in the 
text of a verse. 

Must I supply a translation for every New Testament verse? 
No, but the text of the missing verses will be displayed as “?” in reports. If you don’t have a 
translation for John 1:1 but wanted to put a line in the file for the future, make the text of the 
verse something unique that you can easily search for such as TBD (To Be Determined): 
John 1:1 TBD 

What do I name my translation file? 
The filename must end with .txt. The portion of the filename to the left of the .txt is what is 
displayed in the translation popup. For example, KJV.txt will display KVJ. If you want to 
exclude your translation from report 83, put at least one tilde (~) its filename such as 
~MyNotes.txt or My~Notes.txt or MyNotes~.txt. 
 
Note: A translation file ending with .gtm (supplied by the author of GreekToMe) is encoded to 
ensure the integrity of the Bible text displayed in the program. 

Where do I add my translation file? 
Move it into the translations folder and re-launch GreekToMe. 



 

 

How do I remove my translation file? 
Move it out of the translations folder (or into a subfolder of the translations folder) and re-
launch GreekToMe. 

Can I use an e-Sword or Logos file as a translation file? 
Sorry, no. 

How do I convert a Bible to a translation file for personal use? 
Important: You cannot share your translation file with others unless the source text is Public 
Domain, or you have obtained written permission from the publisher to distribute their 
copyrighted Bible for use with GreekToMe. 
 
Before starting your translation file, review all that was said above in this Section. 
 
Here is a small piece of text from a Bible translation, before being formatted for GreekToMe: 
 

Genealogía de Jesucristo 
Mat 1:1  

I.Nacimiento e infancia de Jesucristo 

Genealogía[1] de Jesús*. 

Libro[2] del origen de Jesucristo, 
hijo de David, hijo de Abrahán:  

Mat 1:2 Abrahán[1] engendró a Isaac, 
Isaac engendró a Jacob, 
Jacob engendró a Judá y a sus hermanos,  

Mat 1:3 Judá[1] engendró, de Tamar, a Fares y a Zara, 
Fares engendró a Esrón, 

Esrón[2] engendró a Arán, 
 
Use the Create Starter Translation command to create a new file for the Translations folder. 
Do not change the book names in the file! The file will begin like this: 
 
Matt 1:1 ? 
Matt 1:2 ? 
Matt 1:3 ? 
 
Use a text editor to edit the resulting file. Put the text of each verse on its own line: 
 
Matt 1:1 Libro[2] del origen de Jesucristo, hijo de David, hijo de 
Abrahán: 
Matt 1:2 Abrahán[1] engendró a Isaac, Isaac engendró a Jacob, Jacob 
engendró a Judá y a sus hermanos, 



 

 

Matt 1:3 Judá[1] engendró, de Tamar, a Fares y a Zara, Fares engendró 
a Esrón, Esrón[2] engendró a Arán, 
Use the editor's find and replace function to remove unwanted characters, such as “[1]” and 
“[2]” in the example above: 
 
Matt 1:1 Libro del origen de Jesucristo, hijo de David, hijo de 
Abrahán: 
Matt 1:2 Abrahán engendró a Isaac, Isaac engendró a Jacob, Jacob 
engendró a Judá y a sus hermanos, 
Matt 1:3 Judá engendró, de Tamar, a Fares y a Zara, Fares engendró a 
Esrón, Esrón engendró a Arán, 
 
Finally, convert each special character to its HTML escape code. Read HTML escape codes 
in this document. Also, use the Help > Internationalization > HTML Codes command in the 
program. The HTML escape codes are required so that a translation file is compatible with all 
the operating systems that GreekToMe supports. 
 
In this small example we must convert these two special characters: 
 
Special Character HTML Escape Code 
á &aacute; 
ó &oacute; 

 
Use the editor's find and replace function to substitute any special characters with their 
corresponding HTML escape code (color added for clarity). 
 
You can optionally insert a copyright notice at the top of the file. 
 
COPYRIGHT:This is the Copyright &copy; notice I want to appear in 
applicable reports. 
Matt 1:1 Libro del origen de Jesucristo, hijo de David, hijo de 
Abrah&aacute;n: 
Matt 1:2 Abrah&aacute;n engendr&oacute; a Isaac, Isaac 
engendr&oacute; a Jacob, Jacob engendr&oacute; a Jud&aacute; y a sus 
hermanos, 
Matt 1:3 Jud&aacute; engendr&oacute;, de Tamar, a Fares y a Zara, 
Fares engendr&oacute; a Esr&oacute;n, Esr&oacute;n engendr&oacute; a 
Ar&aacute;n, 
 
This is what the final text above looks like in Report 11 of GreekToMe:  
 
Matt 1:1 Libro del origen de Jesucristo, hijo de David, hijo de Abrahán: 
 
Matt 1:2 Abrahán engendró a Isaac, Isaac engendró a Jacob, Jacob engendró a Judá y a 
sus hermanos, 
 
Matt 1:3 Judá engendró, de Tamar, a Fares y a Zara, Fares engendró a Esrón, Esrón 
engendró a Arán, 
 



 

 

This is the Copyright © notice I want to appear in applicable reports. 



 

 

12. Greek Dictionary 
Notes on the Built-In Dictionary 
Strong's dictionary supplied with GreekToMe tells how a word is derived and the ways it is 
translated in the KJV version, but the definitions are lengthy and thus don't format well in many 
of the GreekToMe reports. 
 
The Built-In dictionary provides a concise general meaning of each Lexical Word so that those 
new to Biblical Greek can determine which principal Greek words were used to form the 
translation. An interlinear Bible would, of course, aid that task. 
 
A word can have various meanings depending on its context. Greek prepositions (prep.) in 
particular can vary widely in meaning. If a Lexical Word has [or was perceived to have] multiple 
meanings, a semicolon separates them. Within each meaning, variations are separated by a 
comma or slash, and in general, the most likely word (or phrase) is the first listed…or at least 
the one you should try first. 
 
Modern terms are favored over archaic terms. Search the KJV translation or Strong's 
dictionary to find an archaic term such as forswear. 
 
The meaning of a noun is given in the singular except for a few cases where that noun is 
usually referred to in the plural (e.g. alms, Jews, morals, senses, spices, weeds). The grammar 
of a Greek word shown in GreekToMe tells you whether it should be translated as singular or 
plural. Occasionally a singular noun in Greek is treated as plural in English such as “the 
people…they” in Luke 19:48. The word “love” could be a verb or a noun in English so grammar 
hints like (v.) and (n.) are sometimes appended to a meaning. 
 
The person, number, tense, voice, and mood of a Greek verb tell how to adapt the concise 
meaning to the context. A verb with the concise meaning “baptize” might be translated 
anywhere from “I baptize” (1 pers. sg. pres. act. indic.) to “they were baptized” (3 pers. pl. aor. 
pass. indic.) depending on the grammar attributes of that verb in context. For 3rd person 
singular (3 pers. sg.) verbs, [he], [she], or [it] was determined by context. A participle is 
classified under a verbal lexical word. 
 
For educational purposes, a verb, participle, or infinitive of a lexical word occurring only once 
(1x) in the Greek New Testament is translated literally in the context of the verse in which it 
appears. Be sure to look for a “not” (various forms of ou and mh) nearby a verb which negates 
the meaning of the verb as in Gal 6:7: not + [he is] mocked = he is not mocked. 
 
The entire Built-In Dictionary may be viewed by selecting Built-In in the Dictionary menu, 
changing to report 44 in the Report menu, and choosing the Highlight Everything! command 
in the Search menu. 
 
The Built-In Dictionary may be amended in future versions of GreekToMe. 

Can I supply my own Greek Dictionary? 
Yes. The Greek Dictionary supplied with GreekToMe is from Strong’s Exhaustive Concordance 
by James Strong. However, you can create a Greek Dictionary file that GreekToMe can read. 



 

 

How do I start my own Greek Dictionary? 
See the Create Starter SRN Dictionary command in Section 4 of this document. 

What is the format of the Greek Dictionary? 
This is the format of each line of a text-only file: 
StrongsReferenceNumber<space or tab>definition of lexical word 
corresponding to Strong’s Reference Number.<return> 
 
Example line 1: 
4982 sozo from a primary sos (contraction for obsolete saos, "safe"); 
to save, i.e. deliver or protect (literally or figuratively):--heal, 
preserve, save (self), do well, be (make) whole. 
 
In Example line 1, the dictionary definition begins after the <space or tab> and ends at the 
<return>. 
 
Example line 2: 
4982 sozo /*save, heal*/ from a primary sos (contraction for obsolete 
saos, "safe"); to save, i.e. deliver or protect (literally or 
figuratively):--heal, preserve, save (self), do well, be (make) 
whole. 
 
In Example line 2, the dictionary definition is “save, heal” and the rest of the text in the line 
before the /* and after the */ is ignored. This allows personal reference notes on either side of 
the /*…*/ while developing a dictionary. Only one set of /*…*/ is allowed per line. No text or 
whitespace (/**/ or /* */) is an empty definition and will be displayed as “?” in the program. 
 
Note: In computer programming /*…*/ is used to insert a comment which is ignored by the 
program, but in a dictionary for GreekToMe it means the opposite: it is the text to keep! 
 
Note: In the Strongs.txt supplied with GreekToMe, an H before a number means it's the SRN 
of a Hebrew word. 
 
See the Internationalization section for information on how to use HTML escape codes in the 
text of a dictionary entry. 
 
In v7.4.1 and later, to specify a copyright notice for the dictionary, begin any line (e.g. the first 
line of the file) with COPYRIGHT: followed by copyright notice such as: 
COPYRIGHT:This is the Copyright &copy; notice I want to appear in 
applicable reports. 

Must I supply a definition for each Strong Reference Number (SRN)? 
No, but the text of the missing definition will be displayed as “?” in reports. 

What do I name my Greek Dictionary file? 
The filename should end with .txt. However, if you are developing a dictionary file, your work 
file may use an ending of .c (e.g. Work File.c) so that you may drag it onto a programmer's 
editor to view (and edit) the /*…*/ portion of each line in a different color. The portion of the 



 

 

filename to the left of the .txt is what is displayed in the translation popup. For example, 
Strongs.txt will display Strongs. 

Where do I move my Greek Dictionary file? 
Move it into the dictionaries folder and re-launch GreekToMe. 

Can I create a Greek Dictionary file using Goodrick/Kohlenberger (G/K) 
numbers instead of Strong’s Reference Numbers (SRN)? 
Yes. You must include “(GK)” in the dictionary filename such as MyDictionary (GK).txt. If you 
have a G/K dictionary but are displaying SRN, or vice-versa, GreekToMe will convert between 
the numbering schemes to display the corresponding definition(s). Your file should include a 
line for G/K “899” and a line for G/K “899a” (which is a special case for autou). If desired, you 
can move the “899a” to the end of the file so the line numbers of the file match the G/K 
number. 
 
Note: When two G/K numbers correspond to one SRN number, displaying G/K numbers with 
the current dictionary being SRN-based will display the same [SRN-based] definition for both 
G/K numbers. 

How do I prepare my Greek Dictionary work file for distribution? 
Use the “Export Dictionary for Distribution” command to create a new dictionary file (ending 
with .txt) which will not contain any of your comments. Since the default folder is the 
dictionaries folder, be careful not to save over any important work when exporting your 
dictionary file! Test your exported dictionary before distributing it. If necessary, move it into the 
dictionaries folder and/or re-launch GreekToMe if you don't see your newly-exported 
dictionary file in the Dictionary menu. 

Notes on the "Mounce (GK)" Dictionary file 
Mounce Concise Greek-English Dictionary 

of the 
New Testament 

 
edited by William D. Mounce 

with Rick D. Bennett, Jr. 
 
Introduction (as stated in the original source file) 
 
This dictionary includes all the Greek words that occur in the standard Greek New Testament, 
and is organized in alphabetic Greek order. The first line of each entry includes the G/K and 
Strong’s number. Strong’s numbers followed by a lowercase letter (a, b, etc.) represent forms 
not included in the original Strong’s system that were modified to conform to modern editions 
of the Greek New Testament. This same system is employed in the various Key Number 
tagged texts in Accordance such as the ESV, NRSV, HCSB, and NKJV. Following this are the 
Greek word, its transliteration, and its frequency count is also included with a hyperlink to this 
form in the Greek New Testament in Accordance. On the second line are the English 
definition, and for all words occuring 10x or less, each Scripture reference is included. The 
third line includes a series of Word Study Hyperlinks which search the corresponding English 



 

 

version for the key number(s) under discussion. Note that there may be variations in frequency 
and usage in each version depending on the translation, and tagging philosophy. 
 
Abbreviations and Symbols 
 
absol. absolute 
acc. accusative 
act. active 
adj. adjective 
adv. adverb 
allegor. allegory, allegorical 
aor. aorist 
BDAG Bauer, Walter and Frederick William Danker. A Greek-English Lexicon of the New 

Testament and Other Early Christian Literature, 3rd edition. Chicago: University of 
Chicago Press, 2001. 

cf. confer, compare 
compar. comparative 
conj. conjunction 
dat. dative 
dimin. diminutive 
e.g. exempli gratia, for example 
esp. especially 
equiv. equivalent 
etc. et cetera, the rest 
fem. feminine 
fig. figurative, figuratively 
freq. frequently 
gen. genitive 
genr. generic, generically 
GK The following number in bold is the Goodrick-Kohlenberger number. 
i.e. id est, that is 
impers. impersonal 
impl. implication 
indecl. indeclinable. The word under discussion will not change its form regardless of 

usage. 
ind. indicative 
infin. infinitive 
inscr. inscription 
interj. interjection 
interrog. interrogative 
intrans. intransitive 
lit. literal, literally 
masc. masculine 
met. metaphor, metaphorically 
meton. metonymy. The use of one word for another that suggests it. 
mid. middle 
neut. neuter 
NT New Testament 
opp. opposition 



 

 

OT Old Testament 
pass. passive 
perf. perfect 
pl. plural 
pluperf. pluperfect 
pr. proper, properly 
prep. preposition 
pron. pronoun 
S The following number in bold is the Strong’s number. 
seq. following 
sg. singular 
signif. significant 
spc. specifically 
subj. subject 
subscr. subscription 
subst. substantive, substantively 
synec. synecdoche. A word in which a part is representative of the whole. 
trans. transitive 
trop. tropical, or figurative 
voc. vocative 
 
* Indicates an entry where all occurrences of the word in the NT have been noted. 
→ Indicates a cross-reference for the following word(s) in Mounce’s Complete 

Expository Dictionary of Old and New Testament Words (Zondervan: 2006). 
☞ Indicates a word study hyperlink to the following Key Number texts in Accordance, 

illustrating how each translation renders the word under discussion. 
 
Variations in the implementation for GreekToMe and GreekToMeLite 
 
• The Greek lexical word and its transliteration from the first line of each entry are output. 

They are followed by an em dash ( — ) and the dictionary definition from the second line. 
• Strong's reference numbers aren't included because you can easily switch between 

displaying the G/K number or SRN in GreekToMe/GreekToMeLite. Furthermore, the 
primary source to relate the G/K numbers and the SRNs came from The Analytical Lexical 
to the Greek New Testament by William D. Mounce. 

• The frequency on the first line of each entry isn't included in the output because in most 
cases the frequency would match the frequency displayed by GreekToMe/GreekToMeLite 
based on the underlying UBS Greek text. Plus, note what was wisely said about "variations 
in frequency and usage" in the Introduction above. 

• The * symbol (as defined above) is included in the output. 
• The → symbol (as defined above) with it cross-reference is included in the output. 
• The ☞ symbol and word study hyperlink(s) are not really applicable to 

GreekToMe/GreekToMeLite and not included in the output. 
• The line starting with "GK G7000" is G/K 899a in GreekToMe/GreekToMeLite. 
• The lines starting with "GK G7005" and "GK G7007" aren't supported by 

GreekToMe/GreekToMeLite and were ignored. 
• The "[4887.5]" definition was appended to the G/K 4887 definition, separated by a pipe (|). 
• The ". See PhotoGuide." was replaced with a period, and in G/K 1170 "See PhotoGuide" 

was removed. 



 

 

13. The Interactive Report Area 
This section describes what happens when you click or make text selections in the report area. 
 

Action Effect 
Click or double-click a Greek 
word: 
 

 
 

If the chosen report displays the words of a verse left-to-right or top-down so 
that the word can be examined in the context of that verse (i.e. Reports 10, 
13..15, 21..26, 41, 42, or 82): 
 
Verse field gets current verse (e.g. John 3:16). 
Word field gets Greek word clicked. 
Lexical Word field gets the lexical word of Greek word clicked. 
Search field gets Greek word clicked. 
 
Book List is scrolled to book of Verse field (e.g. John). 
Verse List is scrolled to verse in Verse field. 
Word List is scrolled to word in Word field. 
Lexical Word List is scrolled to lexical word in Lexical Word field. 
Grammar List is scrolled to grammar of Greek word clicked. 
 
The description displays the lexical word definition of the current dictionary. 
 
If the chosen report is other than listed above, the grammar of the word 
clicked cannot be determined in the context of a verse, and thus: 
 
Verse field is cleared. 
Book, Verse, and Grammar Lists are scrolled to the top. 

Click or double-click a Greek 
lexical word: 
 
 

 

Verse field is cleared. 
Word field is cleared. 
Lexical Word field gets lexical word of Greek word clicked. 
Search field gets Greek word clicked. 
 
The description displays the lexical word definition of the current dictionary. 
 
Lexical Word List is scrolled to word in Lexical Word field. 
Book, Verse, and Grammar Lists are scrolled to the top. 

Click non-Greek text: 
 

 
 

Search field and description are cleared. 

Text selected (start of selected 
in non-Greek text): 
 

 
 

Search field gets the selected text (e.g. loved). Note: The program limits the 
amount of text copied in the Search field. 
 
The description displays the total number of times the selected text occurs 
in the report area. Remember that you can press F3 to find the next 
occurrence of the text shown in the Search field. 

All the text in the report area is 
selected. 

The description displays “(The entire report area is selected.)”. 

Hover mouse over a raised 
square (⸋) in the translation 
text. 
 

The mouse pointer changes to a hand, and the translation note is 
momentarily displayed. 
 

 
Click mouse on a raised 
square (⸋) in the translation 
text. 

The translation note is displayed in a dialog. 



 

 

14. The Magnifier Window 
What is it? 
The magnifier window helps an audience see the details of the GreekToMe display by copying 
a portion of the screen near where the mouse is pointing and displaying it twice the size. 
 
Notes: The magnifier window works only on the primary screen. Also, the magnifier window 
does not work correctly on Ubuntu; it only seems to paint a magnified portion of the desktop 
window! 
 
The magnifier window is implemented as a toolbar. When the toolbar first appears it is in a 
“docked” state. 
 
The default location of the magnifier window is the bottom right-hand corner of the screen. If 
the magnifier window is visible, most of the dialogs in GreekToMe will be placed in the upper 
left-hand corner of the screen when they are opened to minimize obstructing the magnifier 
window. You may drag the toolbar’s title bar to a more convenient viewing location. 

 
 
The red ellipse focuses the viewer’s attention to where the mouse is pointing. The ellipse is 
usually in the center of the magnifier window, but it will move from the center as the mouse 
approaches the left or top edge of the screen. 
 



 

 

Technical notes: The magnifier window tracks most mouse movements in the GreekToMe 
window. However, it cannot directly track every movement (e.g. an activated popup) or 
keystroke. To compensate for those limitations, the magnifier window is automatically updated 
about twice a second based upon the last known mouse location. 

How do I invoke it? 
Click in the upper left corner of the GreekToMe window (near letter A) just below the menu 
bar: 

 
 

How do I close it? 
Click its close box. 



 

 

15. Internationalization 
Internationalization allows the program to be translated for other languages. This section is for 
those who want to translate the GreekToMe program for a new language. The program 
already contains (non-U.S.) English, French, and Spanish. External files may be added to 
translate each U.S. English phase contained in the program to another language. When a new 
file is completed, it could be included inside the program in a future release. 

Can I create my own language file? 
Yes. The GreekToMe web site (obtained by choosing About GreekToMe… in the Help menu) 
has the latest starter language file with the most recent phrases that you can download and 
edit with a text editor. Always use a plain text editor to make changes to a language file. 

What do I name my translation file? 
You can find the default language code and country code of your workstation by choosing 
About GreekToMe… in the Help menu. For other languages, choose the Internationalization 
command in the Help Menu and locate the 2-letter Java language code in the left column that 
corresponds to the desired language. For example, the language code for English is en and so 
the English translation file is en.txt. 

What is the format of a language file? 

HTML commands 
The language file contains HTML commands, but they are included only for the purpose of 
proofreading the whole file with a web browser. The HTML commands—actually, all lines 
beginning with a less-than sign (“<”)—are ignored by GreekToMe. 

HTML comments 
If you want to put a comment in the language file, begin the comment with “<!--”, and end the 
comment with “-->” like this: 
 
<!-- This is an HTML comment which will be ignored by GreekToMe and web browsers. --> 

An example language file entry 
Here is an example from the en.txt language file: 
 
US "Change {0} Color" 
<br> 
** "Change {0} Colour" 
<p> 

The US line 
There is one tab between the US and the double-quote that follows it. The US line must end 
with a double-quote ("). The US line contains the exact phrase to the translated. Do not 
modify the US line or else GreekToMe will not be able to match on it! 



 

 

The ** line 
** is two asterisks. There is one tab between the ** and the double-quote that follows it. The ** 
line must end with a double-quote ("). The ** line has three purposes: 
 

1. It tells the program that there are no more translations for the US line above it. 
2. It defines the default translation for the US line if the language chosen from the 

Languages menu does not have a particular country (e.g. English, as opposed to 
English:United States). 

3. It should contain the translation that is most widespread in the world. 

An empty ** line 
If the ** line is empty between the double-quotes it means the US line never needs to be 
translated. This is common only in the en.txt language file as shown in this example: 
 
US "Words" 
<br> 
** "" 
<p> 

A typical ** line 
In most language files, the ** line contains the primary translation (of the preceding US line) as 
in this example from the fr.txt language file: 
 
US "Books" 
<br> 
** "Livres" 
<p> 

Customizing a translation for a particular country code 
If "Livres" needed to be translated differently when French:Canada was chosen from the 
Languages menu, a line with a Java country code of CA would need to be inserted between 
the US line and the ** line: 
 
US "Books" 
<br> 
CA "Livres+" 
<br> 
** "Livres" 
<p> 
 
The CA line contains the translation phrase to be used when the language chosen in the “Look 
& Feel” menu is French:Canada. Thus, if “French:Canada” were chosen from the Languages 
menu the program would display “Livres+”. But, if “French” (or any other French: language 
menu item besides “French:Canada”) were chosen from the Languages menu the program 
would display “Livres”. 
 
The valid country codes for each language code can be viewed by choosing 
Internationalization in the Help menu. 



 

 

Identifiers 
Occasionally an item to be translated appears in different contexts. For example, “John” could 
be the short book name, the long book name, or the author in the Author List. In these cases 
an identifier is used to uniquely identify that translation item. The same identifier used in the 
US line must be used in the ** line. 
 
US 1,"John" 
<br> 
** 1,"Translation for short book name John in reports and Book List" 
<p> 
 
US 2,"John" 
<br> 
** 2,"Translation for long book name John in reports" 
<p> 
 
US 3,"John" 
<br> 
** 3,"Translation for author John in reports and Author List" 
<p> 

Placeholders for parameters 
A placeholder hold tells the program where to substitute a parameter in the translated phrase. 
The format of a placeholder is {#} where # is a digit from 0 to 9. You must include all the 
placeholders found in the corresponding US line or else vital information will be lost in 
the translation! The placeholders may be moved around in the ** line (or specific country 
code line) to suite the translation. 

HTML escape codes 
When creating a dictionary file, a Bible translation file, or a language file, an HTML escape 
code should be used for any character that is not in the 7-bit US-ASCII character set. 
 
For example, an e with an acute accent would be represented by &eacute; which starts with an 
ampersand (&) and ends with a semicolon (;). The program will read the HTML escape code 
and convert it into a Unicode character that so that it displays properly on both Mac OS 
X and Windows computers. (This assumes that the font used on the workstation supports 
that Unicode character). 
 
Choose the Internationalization command from the Help menu for a list of the alphabetical 
HTML escape codes (e.g. &eacute;) supported by the program and what the characters they 
produce look like in the fonts chosen in the Font Settings dialog. There are two additional 
HTML escape codes besides those shown by the Internationalization command: 
 
&#•; where • is a decimal value as in &#165; 
 
&#x•; where • is a 2-character or 4-character hexadecimal value as in &#x2021; 
 
Hexadecimal values for Unicode characters can be found at: http://www.unicode.org/charts/. 
Since a font might not support every Unicode character, verify that the HTML escape codes 



 

 

you use are correctly displayed in at least one font that most readers of your text will already 
have on their computers. 
 
In the case of a dictionary file (in the dictionaries folder), HTML escape codes may be used in 
the text of a dictionary entry. 
 
In the case of a Bible translation file (in the translations folder), HTML escape codes may be 
used in the text of a verse. 
 
In v6.2.0, support was added for the following two HTML escape codes: 
 &#8288; zero-width word joiner 
   (Microsoft apparently has not added support for the zero-width word joiner Unicode character 
(&#8288;) used in the NASB-77.gtm, NASB.gtm, LBLA.gtm, and NBLH.gtm files causing Windows to display a square box. 
Starting in v6.2.5, a narrow no-break space Unicode character (&#8239;) is substituted on a Windows platform. Because a 
zero-width word joiner Unicode character works fine for Mac OS X and Ubuntu, and Windows may someday support it, you 
shouldn't avoid using &#8288; between a collapsed note and the following word or phrase is applies to.) 
 &#8239; narrow no-break space 
The Unicode character produced by these escape codes is treated like a standard space when 
parsing the translation (or dictionary) words. The zero-width word joiner character may be used 
between the raised square character (which represents a collapsed translation note) and word 
it applies to, thus making the raised square look more like a footnote marker. Here is an 
excerpt from Matt 8:11 of the NASB.gtm translation file: 
 and {Or <i>dine<i>}&#8288;recline <i>at the table<i> with Abraham 
 
In the case of a language file (in the internationalization folder), HTML escape codes may be 
used in the translated lines (e.g. ** line) between the double-quote symbols. 
 
Finally, if “& ” (i.e. an ampersand followed by a space) is found in the above contexts, the 
ampersand (&) is not treated like an HTML escape code and thus is displayed as “& ” in the 
program. 

How do I preview a language file? 

Viewing the changes in the program 
If the language file (and country code within the file) was present when the program was 
launched, you can simply choose the language and/or country (again) from the Languages 
hierarchical menu. The associated language file is read, and the Clear button is automatically 
clicked. Locate the phrase in the program (e.g. menus, dialogs, etc.) and see if it looks correct. 
If the translated phrase does not fit when viewed in the program then it must be abbreviated. 

Viewing the changes in a web browser 
To view the entire language file with a web browser, copy the language file (e.g. fr.txt) and 
rename the copy so it has the extension “.htm” (e.g. fr.htm). Open the .htm file with the 
browser. If the font currently used by the browser to view web pages supports Unicode 
characters, you ought to be able to see the Unicode characters, similar to how they will appear 
in GreekToMe. If the application used to view the .htm file is able to edit the file, do NOT 
make changes because it will add HTML commands that GreekToMe does not 
understand. Always use a plain text editor to make changes to the language file (e.g. 
fr.txt). 



 

 

Where do I add a language file? 
Move it into the internationalization folder and re-launch GreekToMe. 

How do I remove a language file? 
Move it out of the internationalization folder and re-launch GreekToMe. 

What are the files in the internationalization cache folder? 
The tiny files ending in “.cache” contain what country codes were last found in each 
corresponding language file. Therefore a language file (e.g. fr.txt) needs to be searched for 
country codes that it may contain only if it has been modified. There is also a Locales.cache 
file containing information about the country codes available on the workstation that may be 
deleted (to cause it to be rebuilt when GreekToMe is re-launched). 

Why are some of the phrases in the program not translated? 
Future releases of GreekToMe will add new phrases that need to be translated. Also, it may be 
necessary for the author to modify existing phrases that need to be retranslated. (If you 
customized a language file, you will need to modify your custom language file to account for 
the new or modified phrases.) 
 
When a new feature is added to the program, it may be necessary to release the software with 
phrases that haven’t been translated yet. It may take time for the new phrases to be translated. 
The GreekToMe web site (obtained by choosing About GreekToMe… in the Help menu) has 
the latest starter language file with the most recent phrases. 
 
The internationalization feature was introduced in GreekToMe v5.7.0. Non-U.S. English, 
French, and Spanish language translations were included inside the program in GreekToMe 
v6.0.0. The long-term goal is to include more language translations inside the program. The 
author of GreekToMe is looking to establish relationships with users who can translate the 
phrases for the sake of other users. 



 

 

16. Acknowledgements 
What is the Greek New Testament used? 
It can be considered the United Bible Societies (UBS) 4th Ed., with the following explanation. 
The greeknt.mrp source file was obtained courtesy of http://unbound.biola.edu which internally 
reads “(c) United Bible Societies (UBS) 1992 3rd Ed.” For the UBS4 presentation, the Preface 
to the 4th Edition of the United Bible Societies (UBS) The Greek New Testament, Fourth 
Revision Edition reads, “The text of the edition has remained unchanged.” So the text of the 
4th Edition is the same as the 3rd Edition. The greeknt.mrp source file contained no 
punctuation. The Greek punctuation in the program was entered by hand and then proofread 
using the UBS, Fourth Revised Edition, 1983. For the UBS5 presentation added in v7, 
changes were incorporated based on the Fifth Edition, 3rd Corrected Printing, 2016, which 
reads, “Its text is identical with the 28th edition of the Nestle-Aland Novum Testamentum 
Graece.” The Greek punctuation was again proofread by hand for v7. 
 
There were a few words in the greeknt.mrp source file that had to be modified. For example, 
the word “KATADUNASTEUOME/NOU” in Acts 10:38 had to be changed to 
“KATADUNASTEUOME/NOUS” because the ending “S” was missing. All the word changes 
are listed in GreekToMeRevisionHistory.pdf and most of them were capitalizations. 
 
There were several lexical word errors in the greeknt.mrp source file. Not knowing how many 
were wrong, 109,961 links between each word (in context) and its lexical word had to be 
verified by hand. The following books were used as references: 
 
ISBN 0-567-01021-X A Concordance to the Greek Testament, 5th Ed. 
ISBN 0-943575-33-8 The New Analytical Greek Lexicon 
ISBN 0-310-20377-5 The NIV English-Greek New Testament 
 
16 verses are included in the Verse List which are not in the UBS source file so that the 
translation text can be displayed for translations that have those verses (e.g. KJV): Matt 17:21; 
18:11; 23:14; Mark 7:16; 9:44,46; 11:26; 15:28; Luke 17:36; 23:17; John 5:4; Acts 8:37; 15:34; 
24:7; 28:29; Rom 16:24. The Greek text for these verses is an “X”. To easily find these verses, 
scroll to the bottom of the Grammar List and click the “X” item. 

What was the source of the KJV translation? 
The KJV translation originally included with GreekToMe was compiled from text obtained 
courtesy of http://ccat.sas.upenn.edu. Beginning in v7.1.7, it was compiled from pce.rtf 
obtained courtesy of https://www.soulwinning.info/bible/kjb/pce.htm which includes italics. 

What was the source of the BBE translation? 
The BBE translation available on the author's web site for use with GreekToMe was compiled 
from text obtained courtesy of http://www.gentle.org. 

What was the source of the LEB translation? 
The Lexham English Bible translation available on the author's web site for use with 
GreekToMe was compiled from the LEB.txt file obtained courtesy of 
http://www.lexhamenglishbible.com. 



 

 

What was the source of the LSG (1910) and Reina-Valera (1909) 
translations? 
The LSG and Reina-Valera translations available on the author's web site for use with 
GreekToMe were compiled from text obtained courtesy of http://www.gregwolf.com/bibles.htm. 

What was the source of the NASB-77, NASB, LBLA and NBLH translations? 
The “New American Standard Bible (1977)”, “New American Standard Bible (1995)”, “La Biblia 
de las Américas” (i.e. LBLA) and “Nueva Biblia Latinoamericana de Hoy” (i.e. NBLH) 
translations available on the author's web site for use with GreekToMe were compiled from the 
nasb1977-NT.txt, nasb-NT.txt, “lbla nt.txt” and nblh-nt.txt files, respectively, obtained courtesy 
of http://www.lockman.org. In 2 Timothy 4:1 of nasb1977-NT.txt, “Isolemnly” was corrected to “I 
solemnly”. 

What was the source of the WEBible translation? 
The World English Bible translation available on the author's web site for use with GreekToMe 
was compiled from text obtained courtesy of http://webible.org. 

What was the source of the Strong's Greek Dictionary? 
The Strong's Greek Dictionary included with GreekToMe was compiled from text of a file called 
strongsgreek.dat obtained courtesy of the MacSword project at http://www.macsword.com. 
The text is from Strong’s Exhaustive Concordance by James Strong, S.T.D., LL.D. 1890 which 
is public domain. 

What was the source of the Built-In Dictionary? 
The Built-In Dictionary was compiled by the author using words from public domain dictionaries 
and translations. 

What references were used to identify the Greek syllables? 
The position of the 58,788 hyphens was determined by homogenizing data found in: 
A Grammatical Analysis of the Greek New Testament ISBN 88-7653-588-8 
The New Analytical Greek Lexicon of the New Testament ISBN 0-943575-33-8 
The Complete Word Study Dictionary: New Testament ISBN-0-89957-663-X 
An Introduction To Greek by Crosby and Schaeffer (1928) 
A Greek–English Lexicon of the Septuagint (a good source of ISBN 3-438-05125-7 
 Greek words to help confirm beginning consonant clusters) 
From Unicode to Typography, a Case Study: the Greek Script 
 by Yannis Haralambous (boston99.pdf section 1.5) 

Fonts 
Thank you http://www.teknia.com for providing the TekniaGreek font used in the 
documentation and pre-Unicode versions of GreekToMe! 
 
Thank you http://www.unicode.org for providing excellent coding charts! 

Language Translations 
Thank you Kenneth Ryland for doing the Spanish translation! 



 

 

Look & Feels 
Thank you http://www.jtattoo.net for providing Aero, Bernstein, HiFi, Luna, McWin, Mint, and 
Smart! 

Others 

Wesley Justice for v3 beta testing; bouncycastle.org for helping to ensure the integrity of the 
distributed Bible translation files; Bill Johnston for listening, feedback, and donating memory for 
a PC; Bob Prieb for the SRN redirection idea (£) and suggesting a way to “go back” (which 
was later implemented in the History window); John Barry for donating a PC laptop and new 
battery; John Wilheim for donating a PC for Ubuntu Linux testing; Dr. Al Gregg for helping me 
in my Greek studies; Bethany Wood for helping me with the draft French translation; Pike 
Lambeth of The Lockman Foundation for assisting with the NASB, LBLA and NBLH 
translations; and Andrea King, my wife, for totally supporting me. 

17. Distribution 
GreekToMe (a Greek New Testament Bible study software program) may be distributed for 
non-commercial purposes. The author retains full rights to determine who may or may not 
distribute GreekToMe and in what form. Contact the author (Charles H. King, 2749 N. Stoney 
Point St., Wichita, KS 67205) if you wish to distribute this software in a compilation or for 
commercial usage, or if you have any questions about its redistribution. GreekToMe must be 
distributed with its companion folders and files: 
 
GreekToMe***.jar (for Mac OS X and Windows; *** is the version) 
GreekToMe.pdf 

dictionaries 
  Strongs.txt 

translations 
  KJV.gtm 
  YLT.gtm 
 
Please do not include a GreekToMe.ini settings file. A new GreekToMe.ini will be created 
automatically with default settings. 

18. GreekToMeLITE 
What is the difference between GreekToMe and GreekToMeLITE? 
GreekToMeLITE for Android tablets is a derivative of the GreekToMe program. GreekToMeLITE 
is designed for portability and ease of use, like for a church service. GreekToMe is designed 
for more detailed word studies. GreekToMe has features for educators like the Build-A-Word 
dialog, and features for Bible translators like the Create Starter Translation command. You 
certainly don't have to be an educator or Bible translator to use GreekToMe or 
GreekToMeLITE, and you don't have to know New Testament Greek to use the programs. 

Help in GreekToMeLITE 
GreekToMeLITE is easier to use than GreekToMe. There is no manual. Basic help is available 
inside the program, some of which is repeated in the following comparison tables. 



 

 

Comparison of Basic GreekToMeLITE Features 
(The blue items are for users who are familiar with the Greek alphabet.) 
 

Topic GreekToMe GreekToMeLITE 
Change Dictionary Dictionary menu Press Dictionary (3rd) button and then choose menu 

item. 
Change Font Size Font Settings dialog LONG press left edge of either text area to decrease font 

size. 
LONG press right edge of either text area to increase 
font size. 

Change Translation Translation menu Press Translation (2nd) button and then choose menu 
item. 

Change UBS 
Version 

File > UBS Version Options > Greek Area (middle) > Choose UBS Version. 
Or, press “GreekToMeLite : UBS#” app name. 

Collapse 
Translation Notes 

Options > Collapse 
Translation Notes  

LONG press center of Translation Area, unless URL is 
displayed in Translation Area. 

Colors 8 user-defined colors. 6 preset color schemes in Options > Colors. 
Grammar Attributes Set Grammars button and 

dialog 
Not supported, but can view in the Report Area the 
grammar of each Greek word of the current verse of the 
Translation Area. 

Help Help > Read 
GreekToMe.pdf 

Options > Help > Text Areas Help 
Options > Help > Buttons Help 
Options > Help > Font Size Help 
Options > Help > External Files Help 

Highlighted Greek 
word 

Greek word is colored in 
Word List and Report area. 

Greek word is underlined. 

Notes Not supported; use TextEdit 
or NotePad, etc. 

Options > Notes 

Pattern Search 123 pattern search button Not supported. 
Print report Print command Not supported. 
Reader Greek Mode Report > Verse > Report 09 Options > Report Area (bottom) > Reader's Greek Mode 
Reader Greek 
Settings 

Commands > Reader's 
Greek Settings 

Options > Report Area (bottom) > Reader's Greek 
Settings 

Reference Help > Quick Reference Portions of GreekToMe Quick Reference. 
Report area Text area, approximately 

the bottom half of main 
window. 

Three text areas: Translation Area at top, Greek Area in 
middle, and Report Area at bottom. 

Reports 40 reports 1 report 
Screen rotation 
options 

Not applicable for 
laptop/desktop computer. 

Lock Orientation 

Search Dictionary Search field + F9, Search 
Phrase dialog (containing 
buttons for each character 
in current translation and 
dictionary). 

Press Search (4th) button or magnifying glass icon at 
top. 
Enter accent-sensitive dictionary phrase to search for. 
Press Search dictionary button in Search dialog. 

Search Greek 
Lexical Words 

Lexical Word List, Lexical 
Word field, Build-A-Word 
dialog 

Press Search (4th) button or magnifying glass icon at 
top. Use non-accented letters a-z to represent the Greek 
letters. 
Press Search Greek Lexical Words button in Search 
dialog. 

Search Greek 
Words 

Word List, Word field Press Search (4th) button or magnifying glass icon at 
top. Use non-accented letters a-z to represent the Greek 
letters. 
Press Search Greek Words button in Search dialog. 



 

 

Search Match, 
Previous 
Search Match, Next 

Not applicable, because all 
search results are always 
displayed in all lists and the 
Report area. 

Press up arrow icon at top. 
 
Press down arrow icon at top. 

Search Translation Search field, Search Phrase 
dialog (containing buttons 
for each character in current 
translation and dictionary). 

Press Search (4th) button or magnifying glass icon at 
top. 
Enter accent-sensitive translation phrase to search for. 
Press Search Translation button in Search dialog. 

Set Functions MC, M+, M-, Mx, MR 
buttons 

LONG press Verse (1st) button (or heart icon at top) for 
simplified memory functions, similar to MC, M+, and MR 
buttons in GreekToMe. 

URLs in dictionaries Click URL in the Report 
area, or the Description. 

Press URL in the Report Area. 

URLs in translations Click URL in the Report 
area. 

Press URL in the Translation Area. 

User-defined Book 
Names 

Files > Book Names dialog Not supported, except though optional language file. 

Verse entry Verse List, Verse field, or 
Verse Selector 

Press Verse (1st) button for Verse Selector dialog. 

Verse, Select Next Commands > Select Verse 
Next 

Press right edge of Translation Area or Greek Area. 

Verse, Select 
Previous 

Commands > Select Verse 
Previous 

Press left edge of Translation Area or Greek Area. 

Verse, Select 
Random 

Commands > Select Verse 
Random 

Use Random button in Verse Selector dialog. 

Comparison of Advanced GreekToMeLITE Features 
There are a few advanced features in GreekToMeLITE — most users will ignore them. For 
information on those advanced features of GreekToMeLITE, such as creating your own Bible 
translation file, understand the feature by getting to work first in GreekToMe (on a 
laptop/desktop computer), and then transfer your working translation file to your Android. 
 
In Android 9 and earlier, optional external files are placed in folders below the Android/data/ 
greektomelite folder. If you uninstall GreekToMeLite, your external files will remain. 
 
In Android 10 and later, optional external files are placed in folders below the 
Android/data/org.kx9s.greektomelite/files/Documents folder. Because of new Android security 
limitations, to access these folders directly, you must connect your Android device to your 
computer. But in GreekToMeLite 3.1.4 and later, you can import (or re-import) a (.txt) 
translation or dictionary file by pressing and HOLDing the Translation or Dictionary button. If 
you uninstall GreekToMeLite, the Android operating system will DELETE the 
Android/data/org.kx9s.greektomelite folder! 
 

Topic GreekToMe GreekToMeLITE 
Change Font Font Settings dialog Options > Translation Area (top) > External Font File 

Options > Greek Area (middle) > External Font File 
Options > Report Area (bottom) > External Font File 
 
The default font of the Translation Area is the Android device's default 
text font. The default font of the Greek Area and Report Area is Galatia 
SIL Regular (GalSILR.ttf). 



 

 

Dictionaries Put additional SRN-
based or G/K-based 
dictionary files in: 
/GreekToMe/dictionaries 

Put additional SRN-based or G/K-based dictionary files in: 
Android 9 and earlier: 
Android/data/greektomelite/dictionaries 
 
Android 10 and later: 
Android/data/org.kx9s.greektomelite/files/Documents/dictionaries 
In GreekToMeLite 3.2.8 and later, press and Hold the Dictionary button 
in order to choose your (.txt) dictionary file to import (or re-import) from 
your Documents folder or other folder. You may also delete a dictionary 
using the Delete Dictionary menu item in Report Area (bottom) menu, 
except for dictionaries included by default with GreekToMeLite. 

Fonts Install fonts as usual for 
laptop/desktop 
computers. 

Put optional font files in: 
Android 9 and earlier: 
Android/data/greektomelite/fonts 
 
Android 10 and later: 
Android/data/org.kx9s.greektomelite/files/Documents/fonts 
In GreekToMeLite 3.2.8 and later, choose "Select Font File" for the top, 
middle, or bottom text areas to change the font for that text area. If you 
don't see the font you desire, you will need to install it using a 3rd-party 
Android app. Beware that the font you select might not be able to 
display all the Greek characters properly, especially the accents. 

Internationalization Put additional language 
files in: 
/GreekToMe/ 
internationalization 

Put additional language files in: 
Android 9 and earlier: 
Android/data/greektomelite/internationalization 
 
Android 10 and later: 
Android/data/org.kx9s.greektomelite/files/Documents/internationalization 
In GreekToMeLite 3.2.8 and later, choose "Import Internationalization 
File" to import (or re-import) a file that translates the U.S. English 
phrases used in GreekToMeLite for another language, such as de.txt for 
German. Be sure to read Section 15 first! If you need to delete an 
internationalization file, connect your Android to your computer and 
delete the file. 

Logs (for 
diagnosing 
problems) 

/GreekToMe/logs Android 9 and earlier: 
Android/data/greektomelite/logs 
 
Android 10 and later: 
Android/data/org.kx9s.greektomelite/files/Documents/logs 

Quit Program File > Quit command If necessary, such as after changing related external files, use the 
Options > Help > Force Quit! command. 

Translations Put additional Bible 
translation files in: 
/GreekToMe/translations 

Put additional Bible translation files in: 
Android 9 and earlier: 
Android/data/greektomelite/translations 
 
Android 10 and later: 
Android/data/org.kx9s.greektomelite/files/Documents/translations 
In GreekToMeLite 3.2.8 and later, press and Hold the Translation button 
in order to choose your (.txt or .gtm) translation file to import (or re-
import) from your Documents folder or other folder. You may also delete 
a translation using the Delete Translation menu item in Translation Area 
(top) menu, except for translations included by default with 
GreekToMeLite. 

Android Permissions 
If you put files into one of the folders mentioned above, such as: 
Android/data/greektomelite/translations (Android 9 and earlier), or 
Android/data/org.kx9s.greektomelite/files/Documents/translations (Android 10 and later), 



 

 

do the following: 
 Step 1. Options > Help > Force Quit! 
 Step 2. Re-launch GreekToMeLITE 
If GreekToMeLITE doesn't seem to find your files, verify you have given app permissions to 
GreekToMeLITE on your Android device (see example below), and repeat Steps 1 and 2. 
 
Android 9 and earlier: 
 
GreekToMeLITE 
App 
Permissions 

 

 

Before 

 

 

After 

 

 

 
Android 10 and later: 
 
GreekToMeLITE 
App 
Permissions 

 

 



 

 

Before and After 

 

 

After 

 
Note: In Android 11 the permission reads “Allow access to media only.” 

 

 
In Android 10 and later, if you give GreekToMeLITE the above permision, and perform Steps 1 
and 2 above, launching the app will create the correctly-named (empty) folders inside the 
Android/data/org.kx9s.greektomelite/files/Documents folder that are supported by the app. This 
is easier than creating the 5 folders yourself. If after doing the steps above you don't see the 
dictionaries, fonts, internationalization, logs, or translations folder on your computer (such 
as in the Android File Transfer application on Mac OS X), disconnect the UBS cable from your 
Android device and reconnect it, and then see if the folders are now visible to your computer. It 
doesn't make sense why a folder created by GreekToMeLite would actually exist but not be 
visible until disconnecting and reconnecting the USB cable, but it was the only solution found 
while testing on a Samsung Android 11 device. 
  



 

 

19. Word Search Puzzle 
You can create a word search puzzle from a checklist. The Puzzle button in the Checklist 
dialog is enabled when at least one checkist item has a checkmark (✓) and there are no 
unsaved checklist changes. Below is a sample word search puzzle containing the Greek words 
of John 3:16 that were saved in a checklist. For this example, every word in the checklist had a 
checkmark (✓), but any of the checklist items could have been excluded from the puzzle by 
removing its checkmark (✓) in the Checklist dialog. 
 
ἠ γ ά π η σ ε ν τ ὸ ν 
ν ὸ ἱ υ ἔ χ ῃ δ ι κ ν 
α α ἰ ώ ν ι ο ν α µ ν 
τ ὐ ἵ τ π θ ν ν τ ο ν 
ο ν τ ἀ ᾶ ε ε ὴ η ν ω 
α λ λ ὸ ς ὸ κ ω λ ο ύ 
α λ ς ρ ν ς ω ζ ό γ ε 
’ ἰ θ ὰ κ ο δ δ π ε τ 
ε υ ο γ β ν ἔ ὁ ἀ ν σ 
η ὴ µ κ ό σ µ ο ν ῆ ι 
φ ρ ς ω τ ὕ ο υ β θ π 
σ δ µ η ο χ π ε τ σ ὥ 
 
αἰώνιον εἰς κόσµον πιστεύων 
ἀλλ’ ἔχῃ µὴ τὸν 
ἀπόληται ζωὴν µονογενῆ υἱὸν 
αὐτὸν ἠγάπησεν ὁ ὥστε 
γὰρ θεὸς οὕτως  
ἔδωκεν ἵνα πᾶς  
 
Statistics: 
→   5 αἰώνιον, ἔχῃ, ἠγάπησεν, κόσµον, τὸν 
 
←   4 µὴ, οὕτως, υἱὸν, ὥστε 
 
↓   3 θεὸς, µονογενῆ, πᾶς 
 
↑   5 ἀπόληται, γὰρ, ἔδωκεν, ζωὴν, πιστεύων 
 
↗   1 εἰς 
 
↘   1 αὐτὸν 
 
↙   3 ἀλλ’, ἵνα, ὁ 
 
↖   0 
 
  



 

 

Below the rectangular puzzle is the list of puzzle words which have been placed in columns in 
the order they appeared in the checklist. Below the list of puzzle words are the optional 
statistics that show the direction that each word was placed in the puzzle. Because the puzzle 
layout is random, you may need to make it several times until you get a puzzle you like. 
The statistics help you decide if you like the layout (without actually having to solve the 
puzzle). After the word search puzzle is created in the report area, you can copy the report text 
to an editor to format the puzzle as desired. 
 
Note: You can also create a puzzle based on a list of checklist words that contains only non-
accented letters (i.e. English letters in range a-z or A-Z), or numbers (i.e. digits 0-9). The 
program detects this, and when it "fills in" the unused puzzle slots it knows whether to 
substitute them with English letters a-z or A-Z, Greek letters a-w or A-W, or digits 0-9. 
 
The table below this picture explains the Word Search Puzzle Options. 
 

 
 

Component Explanation 
Select word directions to allow: The 8 checkboxes let you control the direction the 

(checklist) words can be placed in the puzzle. For 
example, if you turn off the checkboxes in the 4 corners 
then no words will be placed diagonally. Because the 
puzzle layout is random, turning on a checkbox won't 
guarantee a word will be placed in that direction…it only 
makes it possible. 

Remove Greek Accents If on, Greek letter accents and breathing marks that are 
recognized by the program will be removed from the 
words used for the puzzle. 



 

 

Capitalize Words in Puzzle If on, the (checklist) words used for the puzzle will be 
capitalized. 
If on, the Remove Greek Accents option is required. (This 
is because the program doesn't contain a counterpart 
uppercase Greek letter for each accented lowercase 
Greek letter.) 

Use Same Puzzle Layout If you like the layout of the puzzle you created but you 
want to change one of the other word search puzzle 
options, you can turn on this checkbox to cause the 
program to re-create the puzzle with the same puzzle 
layout. 

Reveal Unused Puzzle Slots If on, the unused puzzle slots won't be "filled in" but rather 
remain a hyphen ("-"). This creates an "answer key" and 
makes it easier for you to see where the words were 
placed in the puzzle. 

Include Statistics If on, you will see in the report area the direction that each 
word was placed in the puzzle. If you like the layout of 
puzzle you created, you can select and delete the 
statistics portion. 

Optional puzzle font (i.e. the 
popup and the sample puzzle 
font area underneath) 
 
 

If an Optional puzzle font is selected, that font will be 
used when formatting the puzzle instead of the Report 
Font (Greek) in the Font Settings dialog. The system's 
"Monospaced" font is selected by default. The 
"Monospaced" font and any font names containing 
"Courier" are included at the top of the popup because 
those fonts are more likely to display a nice-looking 
puzzle. Otherwise, the puzzle letters won't line up and the 
puzzle shape will be uneven instead of a rectangle. 
 
The sample puzzle font area has two lines of text. If the 
pipes (|) at the beginning and end of each line of text line 
up vertically, then that font should be adequate to use for 
displaying the puzzle—and possibly for printing the puzzle 
from within the program. (Turn on Options > Show Print 
Page Width to see where the print margin is.) During 
testing, sometimes the puzzle looked OK in the report 
area and yet some Greek letters didn't print correctly. 
Therefore, before you print lots of copies of your puzzle, 
print one copy and see if it looks OK. 

Word list columns: The slider controls the number of columns of the list of 
puzzle words. The range is 1 to 6 columns. Hint: If you 
plan to copy the puzzle text to an editor, and that editor 
has the ability to flow lines of text into columns, then you 
may want to set the slider to 1 for a single column. 

 
greektome@sbcglobal.net 
greektomelite@gmail.com 
 
The End 


